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Starting DirectAid 

You may get a message on startup indicating that your graphics card does not support 
some features used in DirectAid. The abilities of modern graphics cards go well beyond 
simply drawing pixels to the screen. Rendering which was once carried out by the CPU 
can now be done on a specialized graphics processing unit onboard the graphics card. In 
some cases, it may be necessary to update your graphics drivers before DirectAid will 
work smoothly. If you are using a desktop computer, these drivers can be obtained from 
your graphics card manufacturer. If you are using a laptop computer, you will likely need 
to obtain updated drivers from the laptop manufacturer. If you are having problems 
locating suitable drivers, feel free to contact us and we will try to help. 

The Application Window 

 

Figure 1 - The application window 

When you first open DirectAid, you should see a screen similar to the one shown in 
Figure 1. We will first describe the basic parts of the application window. At the very top 
is the title bar. This contains the application title, system menu, and buttons for 
minimizing, maximizing, and closing the program. Just below this is the menu bar. There 
are seven menus, whose commands will be described in greater detail later on: 

- The File menu contains commands for opening and saving DirectAid workspaces, 
importing data into a workspace, printing, and closing the program. 

- The Edit menu contains commands for cutting, copying, and pasting items, as 
well as commands for undoing and redoing actions. 

- The View menu contains commands for showing and hiding the different 
components of the interface, as well as the Preferences command for setting 
program options. 

- The Camera menu contains commands for changing the camera. 
- The Select menu contains commands for setting the selection mode. 
- The Tools menu contains commands to activate the Rechain, Interpolate, and 

View Templates tools. 
- Finally, the Help menu contains a link to this document, Getting Started. 
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Below the menu bar is the toolbar. You will likely be familiar with some of the buttons, 
and not with others. You can quickly find out what a particular button does by holding 



the mouse cursor over the button for a moment. A small description will appear just 
below the button, and a slightly longer description may appear in the status bar below. 
The buttons on the toolbar are as follows: 

 Create a new workspace 

 Open an existing workspace

 Save the active workspace 

 Set the print area 

 Print the active map view 

 Pan the camera 

 Zoom the camera 

 Rotate the camera 

 Un-zoom the camera 

 Square camera axes 

 Select map objects 

 Select objects in area 

 Measure length and area 

Below the toolbar, on the left, is the layer view. Here you will see a list of all the layers 
which have been loaded into the current workspace. To the right is the map view. 

Finally, at the bottom of the application window is the status bar. The left portion of the 
status bar displays context-sensitive information. If the mouse is over a toolbar button, 
for example, this will show a description of the button. If the mouse is over the map view, 
the status bar will show the position of the mouse cursor. 

The Layer View 

By default, the layer view is located to the left of the map view. By dragging its title bar, 
the layer view can be moved to any position on the screen, or docked on an edge of the 
application window. To show or hide the layer view, choose Layer Bar in the View menu. 

The layer view lists imported layers in a tree structure. Layers are drawn from bottom to 
top, so that a layer at the top of the layer view is drawn on top of all other layers. A layer 
can be expanded by clicking the  symbol to the left of the label, or collapsed by clicking 
the  symbol. A layer can also be expanded or collapsed by double-clicking the label. 

To show or hide a layer, click the check box to the left of the label. If a parent layer is 
hidden, its children will not be drawn. 
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Some layers, such as folders, can be renamed. To rename a layer, either click on the label 
of an already-selected layer, or hit F2 with the layer selected. This will enter label edit 
mode. 

To select a range of layers, click on the first layer, then hold the Shift key while clicking 
on last layer. To add to an existing selection, hold the Ctrl key while selecting. To add a 
range to an existing selection, hold the Ctrl key and click on the first layer of the range, 
then hold both the Shift and Ctrl keys and click on the last layer. 

Some layers can be dragged from one place to another, for example to change the 
drawing order or to arrange layers into folders. The location where a dropped item will be 
placed is indicated either by a selection, in which case the item will be inserted as a child 
of the selected item; or as a line between two items, in which case the item will be 
inserted between the two items. If no selection or line appears, this indicates that the item 
cannot be dropped at the current location. 

By right-clicking on a layer, you can bring up a context menu with common operations 
for the layer, usually including Delete and Properties. By right-clicking on the white 
background in the layer view, it is possible to add items at the root level. 

If the camera is in Earth Centered Earth Fixed (ECEF) coordinates, you will see an 
additional layer called Globe Layer. The globe can be drawn either as a simple grid or 
using NASA’s Blue Marble image. To change the globe mode, right-click on the Globe 
Layer and select a mode from the context menu. 

Layer Properties 

By right-clicking on certain layers, you can access the Properties command. Properties 
for top-level layers usually include the three standard coordinate system pages. In 
addition, properties may include symbol, line, and text colours and formats, as well as a 
page with general information about the layer. To accept changes made in the property 
sheet, click the OK button at the bottom. To close the sheet without applying changes, 
click Cancel. 

Layer properties can be used to change an incorrectly assigned coordinate system tag. It 
is important to remember that changing the coordinate system for a layer does not change 
the underlying data, but rather changes the meaning of that data. For example, if we had 
imported a project but mistakenly assigned it the NAD83 datum, we could later change 
this to NAD27 in the property sheet, and the effect would be the same as if we had given 
it the correct datum in the first place. 

In some cases, a parent layer will contain property sheets relating to its children. In these 
cases, the parent property sheet is populated with the options you might see in the child 
property sheets. If a particular option is set the same in all children, that value will be 
selected in the parent property sheet. Otherwise, the option will be present but no value 



will be selected. Selecting a value in the parent property sheet assigns that value to all of 
the children. 

The Map View 

Panning, Zooming, and Rotating 

You can switch the mouse function between pan, zoom, and rotate modes either using the 
buttons on the toolbar or by choosing the appropriate option in the Camera menu. 

To pan the map while in pan mode ( ), click and drag with the left mouse button. You 
will see the map move with your cursor. If you have a middle button or wheel on your 
mouse, you can pan in any mode by pressing the middle button (or wheel). To use this 
function, click the middle button and then move the mouse away from the original 
position. A small crosshair will appear at the position where you pressed the button. The 
page will move in a direction toward the cursor with a speed which is proportional to 
your distance from the stationary crosshair. If you click-and-drag the middle button, the 
pan will end when you let the button up. Otherwise, the pan will end when you click the 
middle button a second time. 

To zoom the map while in zoom mode ( ), click and drag with the left mouse button on 
the map to define a zoom box. When you let the button up, the camera will zoom to fit 
that region to the page. To zoom out while in zoom mode, just click the left mouse button 
without moving it. If you have a mouse wheel on your mouse, you can zoom in and out in 
any mode using the wheel. You can control the zoom step, as well as the direction 
(whether pulling the wheel toward you zooms in or out) using the Preferences command 
in the View menu. 

To rotate the map, you must be in rotate mode ( ). When you enter this mode, you will 
see a small crosshair appear on the screen. This is the point about which the camera will 
be rotated. To move the point, just click the left mouse button anywhere on the page. To 
rotate around that point, click and drag with the left mouse button. 

To un-zoom the map, click the un-zoom button ( ). If you have loaded project layers, 
this will un-zoom to the extent of the projects. If you do not have projects visible, it will 
un-zoom to the entire extent of the workspace. If you wish to square your camera axes, so 
that right is east and up is north, click the square axes button ( ). 

Coordinate Systems 

In DirectAid, each piece of imported data is tagged with a source coordinate system, 
including the following information: 

- Units of measurement 
- Geodetic datum 
- Projection 
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Every time you import something, you will be prompted for this information. Similarly, 
the map view is associated with an independent coordinate system. This is defined in the 
Camera/Options dialog box. 

The camera coordinate system 

Each layer in DirectAid is stored in its source coordinate system, along with a tag 
indicating what that source coordinate system is. The actual conversion to camera 
coordinates occurs on-the-fly. 

To change the camera coordinate system, choose Options under the Camera menu. The 
options are broken into three groups. The first group, Units, is shown in Figure 2. This 
page controls the units used when displaying positions, lengths, and areas throughout 
DirectAid. To change units, just click the drop-down to the right of the unit. 

 

Figure 2 - Camera units 

The first time you do this, you will see a full unit list, as shown in Figure 3. In subsequent 
uses, you will see an abbreviated list, as shown in Figure 4. To view the full list, just click 
on “more options”. 

 

Figure 3 - Full unit list 
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Figure 4 - Abbreviated unit list 

The second group of options, Datum, is shown in Figure 5. Once again, the first time you 
set the camera options, you will see a full list of datums. Subsequently, you will see only 
an abbreviated list. 

 

Figure 5 - Camera datum 

DirectAid is aware of hundreds of datums, but the most commonly used datums used in 
Canada are outlined in Table 1. 

Table 1 - Common Canadian datums 

Datum Description 
NAD 1927 - Canadian Transformation NAD27 using NTV2 
North American Datum 1983 NAD83 
WGS 1984 WGS84 

Finally, the third group of options, Coordinates, is shown in Figure 6. Library projections 
are divided into “groups”. For example, “Universal Transverse Mercator” is one such 
group. As usual, the group and coordinate system lists come in “full” and “abbreviated” 
versions. The library projections include thousands of coordinate systems used around the 
world. 

One particular coordinate system deserves special mention. If the group is set to “XYZ 
Cartesian ECEF” and the coordinate system to “Earth Centered Earth Fixed”, the map 
will be as though the camera were looking down on the earth from space. In this 
coordinate system, if you zoom out far enough, you should see the globe. 
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Figure 6 - Camera coordinates 

If you are unable to find the projection you’re looking for, please contact us and we may 
be able to tell you where it is located. If, however, your desired projection simply has not 
been included in the library (or if you are using a parametric projection such as a non-
standard Lambert Conformal Conic projection), it is possible to define a custom 
projection. To do this, click on the drop-down next to “Library projection” in the lower 
right and change to “Custom projection”, as shown in Figure 7. 

 

Figure 7 - Changing to custom projection 

The Coordinates page will change as shown in Figure 8. You may now choose a general 
projection and specify the parameters yourself. 

 

Figure 8 - Custom projections 
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Once you have made changes to the camera coordinate system, you can click OK to apply 
those changes and close the options dialog box. Your data will automatically be shown in 
the new coordinate system. Although DirectAid attempts to transform the camera 
position so that you are looking at the same place in the new coordinate system, you may 
need to un-zoom ( ) and re-square your camera axes ( ) when you change the camera 
coordinate system. 

Accuracy and error indicators 

On the right of the status bar are two indicators. When the indicators are lit up, they will 
appear as in Figure 9 below. On the left is the accuracy (ACC) indicator. On the right is 
the error (ERR) indicator. 

 

Figure 9 - Accuracy and error indicators 

DirectAid uses a progressive scheme to transform source data on-the-fly. That is, it will 
transform data in “idle time” while your processor isn’t doing anything else, and it will 
update your display as the data is transformed to a finer resolution. The accuracy 
indicator will light as long as this process is incomplete. You may occasionally notice a 
background image updating as you zoom in and out, or when you pan to a different part 
of the survey. This is normal. When the accuracy indicator goes off, that is your 
guarantee that the data has been transformed to within one pixel error. That is, because 
your display has an inherent inaccuracy, the transformed data is indistinguishable from 
the exact transform. 

When printing, DirectAid will ensure that the workspace has been refined to the 
appropriate error threshold before sending data to the printer (or to a file if you are 
printing to file). 

The error indicator will light when some part of a transform has failed. This usually 
indicates that either the source or camera coordinate system is not valid in the region 
containing your data. For example, the datum “NAD 1927 - Canadian Transformation” is 
valid only within Canada. You may see the error indicator light when transforming an 
image which spans the boundary of the datum. In this case, DirectAid will try to 
determine the region in which the datum is valid, and you will see only the part of the 
image for which the datum is valid. 

Saving and Opening a Workspace 

A workspace can be saved as a DirectAid workspace file. These files include all project 
and vector data contained in the workspace, as well as image georeferencing information. 
In order to prevent duplication of large amounts of image data, this data is not saved as 
part of the workspace at this time. However, it will be loaded automatically from the 
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source image when the workspace is opened. If the source image cannot be located, you 
will be given the option to browse for the image data. 

To save a workspace to disk, choose Save or Save As from the File menu, or use the 
toolbar button ( ). You will be prompted for a file name. As usual, DirectAid will add 
the appropriate extension to the file name if you do not enter one yourself. 

DirectAid 2.0 workspace files can be recognized by their icon ( ). These files can be 
opened by double-clicking the file in Windows Explorer. Files can also be opened from 
within DirectAid by choosing Open from the File menu, or using the toolbar button ( ). 

To create a new workspace, either choose New from the File menu, or click the button on 
the toolbar ( ). 

Projects 

Building a project 

To build a new project within the current workspace, right-click in the white area of the 
layer view. From the context menu, choose New and then Project layer. This will bring 
up the Project Wizard, which can be used to build projects of several types. The first page 
of the wizard is shown in Figure 10. 

 

Figure 10 - Project wizard: general information 

In the General information page, you can select the type of survey you want to build, as 
well as assigning project name and client labels. To select a project type, click on the icon 
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in the list on the left. When you have entered this information, click Next to continue. 
This will lead you to the standard three coordinate system pages. 

The coordinate system specified on these three pages is used to build the project. The 
units you specify will be used to define the project position and extent. The datum and 
coordinate system you specify will be used to define “north” and “east” when building 
the project. 

After you have specified a coordinate system, clicking Next will take you to the Position 
page, shown in Figure 11. 

 

Figure 11 - Project wizard: position 

The position of the survey can be specified either in grid coordinates or in geodetic 
(latitude/longitude) coordinates. To select one of these two methods, click on the drop-
down list at the top of the page. When entering the northeast corner position and size of 
the survey, take note of the units. These are the units you specified in the coordinate 
system pages. If you would like to change the units to something more convenient, click 
the Back button to return to the Units page. 

You may also be able to specify the northeast corner of your project in terms of the 
Dominion Land Survey (DLS) or National Topographic System (NTS) grids if your 
project is in Canada. To use DLS grids, you will need to purchase a copy of the section 
corner database from Terra Management (see “DLS grids” on page 26). When you have 
entered a position and size for the survey, click Next. 
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Figure 12 - Project wizard: basic parameters 

The Basic parameters page, shown in Figure 12, is used to specify the direction of 
receiver and source lines, line spacing, station interval, and a stagger period. 

The stagger period is used to shift lines incrementally in the inline direction. For instance, 
a value of “3” results in what is known as a “triple stagger” survey. In this case, the 
stations of every third line would line up. If you have chosen a line spacing which is a 
multiple of your station interval, a triple stagger would result in a 3x3 grid of midpoints 
within each bin, whereas no stagger (a stagger value of “1”) would result in midpoints 
centered in the bin. 

By clicking the Advanced parameters checkbox at the bottom of the page, you can 
change two additional parameters, shown in Figure 13. These can be used to introduce an 
offset in line or station position. 

 

Figure 13 - Project wizard: advanced parameters 

Depending on the type of survey you have selected, you may encounter one or more 
additional Basic parameters pages following the first one. For diagonal projects, you be 
asked to specify either a rotation or slope for the diagonal, as shown in Figure 14. A 
rotation/slope of “0.0” corresponds with an orthogonal survey.  
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Figure 14 - Diagonal project options 

For a brick survey, you will need to specify the brick period, as shown in Figure 15. In a 
brick survey, the source salvos are offset in the crossline direction by a fraction of the 
source line spacing. This number of salvos between repeated offsets is called the brick 
period. 

 

Figure 15 - Brick project options 

When you have finished entering basic parameters, click Next to move on to the 
Line/station numbering page, shown in Figure 16. 

 

Figure 16 - Project wizard: line and station numbering 

You will probably accept the defaults on this page most of the time. However, you have 
the option here to change which corner your lines and stations are numbered from, what 
the first line/station number is, and what the increment is. When you have finished, click 
Next. You will be shown a summary of the parameters you have entered. To build the 
project, click Finish. The project is added to the workspace, but the map is not changed. 
To view the project, you may need to un-zoom ( ) and re-square your camera axes ( ). 
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Importing and exporting projects 

Importing a project 

To import a project, choose Project layer in the Import pop-up menu. First you will be 
asked to select the files to import. For project layers, all files imported in a single 
operation must be referenced to the same coordinate system, and must share the same 
layout. Once they are imported, these files will be grouped under a single project layer. 
When you have selected one or more files, click Open to continue. 

Next, the project import wizard will appear. The first page of the wizard is shown in 
Figure 17. In this page, you may specify the file layout. At the top right of the page is a 
drop-down box which tells you which file you are currently viewing. Because all the files 
must share the same layout, you can use this control to switch between files and make 
sure the columns are the same in each file. 

 

Figure 17 - Project file layout 

Below the file selection drop-down is the file preview. Using this control you can scroll 
through the entire file to make sure it fits the specified layout. In addition, you will notice 
that a range of rows or columns is selected in the preview. This corresponds with the 
currently-selected field (indicated in the drop-down box below the preview). You can 
change the position and width of a range by clicking and dragging the middle or edges of 
the range using the left mouse button. 

Below the preview is an area used to assign ranges of columns in the SEG-P1 file to 
specified properties in the imported project. By default, the “Field” dropdown is 
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populated with the properties that are needed to create a valid project: header, type, line, 
station, easting, northing, and elevation. Most of the time, you will simply want to check 
that these fields are associated with the correct columns. To do this, select each field in 
turn and scroll through the preview to ensure that the required information sits inside the 
highlighted columns. 

In some cases, you will want to assign user-defined properties to the stations. By default, 
user-defined properties are not set when you import a project. However, you may 
initialize fields using data in the SEG-P1 file (as in Figure 18), or set them to a fixed 
value (as in Figure 19). 

 

Figure 18 - Custom field initialized from SEG-P1 file 

 

Figure 19 - Custom field initialized to fixed value 

To assign values to a field, first select the field from the first drop-down box on the left. 
Next, choose the initialization method. Finally, enter either a range of columns or a fixed 
value for the field. 

This is a good time to make a note of any information which is available in the header of 
the files you are importing, such as datum and projection. When you have made a note of 
this information, click Next to continue. 

What follows are three wizard pages which are very similar to the camera options pages 
described in “The camera coordinate system” on page 5. Use these three pages to specify 
the source coordinate system for the imported files. If you are unsure about this 
information, you may want to make educated guesses, since you can always change the 
source coordinate system later on. When you have reached the last wizard page, click 
Finish to import the files. 

If the files contain stations with duplicate line/station numbers, the Resolve Duplicates 
wizard, shown in Figure 20, will appear. A single group of duplicates is shown in red, 
while the surrounding text is shown in gray. The selected line, marked with a green bar, 
will be kept. The others will be discarded. To move between groups of duplicates, use the 
Previous and Next buttons. When you have checked all the duplicates, click Finish to 
continue. 
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Figure 20 - Resolving duplicates 

If the files contain stations with indeterminate type, The Specify Line Types wizard, 
shown in Figure 21, will appear. To move a line from one column to the other, select it 
and click the appropriate arrow in the middle. When you have assigned all the line types 
correctly, click OK to continue. 

 

Figure 21 - Specifying line types 
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When the import operation is complete, DirectAid will create a new layer in the layer 
view. You may need to un-zoom ( ) in order to see the project. If you still cannot see the 
project, check if the error indicator is lit. This may indicate that you have chosen a datum 
or projection which is not valid for the project area.  

Exporting a project 

A survey layer is the immediate child of a project layer, and represents a group of project 
lines. Typically, a project layer will have a child survey layer for sources, and another for 
receivers. A survey layer can be exported to a SEG-P1 file, an SPS point file, or a 
comma-separated value (CSV) file. 

To export a survey layer, right-click on the “Source” or “Receiver” layer in the project to 
access the context menu, then choose the Export command. You will be prompted for a 
file name and type. DirectAid 2.0 will add the appropriate extension to the file name if 
you do not enter one yourself. When you have done, click Save to continue. Next, you 
will be presented with the survey export wizard. This wizard consists only of the three 
coordinate system pages. Default values will be the same as the source coordinate system 
for the parent project. Your choices here affect only the exported data, and will have no 
effect on the project layer itself. Files are written in the standard format as outlined by the 
Society of Exploration Geophysicists (http://seg.org/publications/tech-stand/). 

When writing SPS point files, by default the point code (columns 27-28) will be blank. 
The point code consists of two characters which indicate the station type (e.g. geophone, 
hydrophone, vibroseis, explosive, air gun). The specific point code used for each station 
type is not defined by the SPS specification, so we’ve left this up to the user. To set the 
point code for a group of stations, first select the stations. Right-click on the selection and 
choose Properties from the context menu. If needed, add the “_SPS_Point_Code” built-in 
property, as described in “Setting properties” on page 19. Enter a one- or two-character 
point code in the text box and click OK to make the change. 

The wizard for exporting to CSV is similar to the SEG-P1 and SPS export wizards, 
except that it includes an initial page for specifying which data should be written to the 
file, as shown in Figure 22. 
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Figure 22 - CSV columns 

Fields can be moved between the “Available fields” column and the “Fields to write” 
column, or re-arranged within the latter. Note that both built-in fields and user-defined 
fields are available to be written. When you have selected the fields to be written, click 
Next and continue as for SEG-P1 export. 

Project properties 

Each project has several attributes which can be accessed through the General tab of its 
Properties dialog box (see “Layer Properties” on page 3). These attributes are shown in 
Figure 23. 

 

Figure 23 - Project properties 

The values in these fields are used to populate the header of exported SEG-P1 and SPS 
files, and also for labels in some reports. 
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Flexible Properties 

It can sometimes be helpful to be able to assign properties to a layer. These properties can 
then be displayed in the map, used as a filter in some operations, and inserted into labels 
and reports. 

The basis for DirectAid’s property mechanism is the field. Fields allow us to define the 
type of data and how it will be displayed. For example, one possible field would be “hole 
depth”. Hole depth is a number. It might be displayed as a circle around the shot, with a 
radius which depends on depth. 

A property is a particular instance of a field. For example, some shots may have a hole 
depth while others do not. Once the field is defined, we can add a property of that type to 
any layer. In the example above, a particular shot might have a hold depth of “20.0”. 

Managing fields 

To add new fields, use the Manage Fields tool, located in the Tools menu. The tool is 
shown in Figure 24. 

 

Figure 24 - The Manage Fields tool 

To add a new field, click Add. This will display the Field Properties dialog box, shown in 
Figure 25. 

 

Figure 25 - The Field Properties dialog 

First, we need to give a name to the field. This is the name that will be used to identify 
the field in property dialogs, filters, and reports. Using our example above, a good name 
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might be “Hole depth”. Finally, we need to choose a data type for the field. These data 
types are described in the table below: 

Data Type Description 
Boolean True or false. 
Double A real number (e.g. 3.1415). 
Enumeration One of a set of items (e.g. “apple”, “orange”, “banana”). 
Integer A whole number (e.g. 5) 
String Text (e.g. “The sixth sick sheik”). 

In our example, the data type would be Double. If we choose “enumeration”, a box will 
appear below the Data type selection. In this box, enter the items to be enumerated, one 
per line. 

The Visualization button is used to define how the field will be displayed in the map. 
This is discussed in greater detail in the section “Displaying properties” below. 

Setting properties 

Now that we have set up a field, we probably want to set some properties using the field. 
There are two basic ways of doing this: using the Properties dialog box, or as a side-
effect of the project editing tools. 

Using the Properties dialog box 

The Properties dialog box for many layers contains a page also called Properties. This is 
used to edit flexible properties manually. At the bottom of the page is an Add Field 
button. This can be used to add fields without having to exit the Properties dialog box. It 
is a short-cut to the Field Properties dialog box described above. The remainder of the 
page is composed of a series of property definitions, one per line. Initially, there is just 
one blank line, as shown in Figure 26. 

 

Figure 26 - A blank property line 

If we click on the drop-down at the left, we will see a list of fields we have defined. 
When we choose a field from this list, the blank space to the right becomes a set of 
controls for defining the property. For example, if we select the “hole depth” field 
defined above, we get the property line shown in Figure 27. 

 

Figure 27 - A typical property line 
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We can enter a value for the property in the box. The contents of this area will depend on 
the field. For an enumeration field, for example, it will be a drop-down list of items. For a 
Boolean field, there is no data at all—the existence of the property indicates a “true” 
value. 

To the right of the property settings are  and  buttons. These are used to delete a 
property or insert a new one. When you have finished setting properties, click OK to 
close the Properties dialog box. 

Using project editing tools 

The most common way of changing a layer’s properties is as a side-effect of using one of 
the project editing tools. For example, suppose we have built a theoretical survey and 
have obtained air photos. Our next step might be to move some lines to existing trail. It 
would be handy if the tool could mark the rechained sections as “existing” so that we can 
use this information in our reports later on. Several of the tools have a Properties button 
for this purpose. 

Suppose, as mentioned above, that we want to mark rechained sections of line as 
“existing”. First, we need to set up a Boolean field called “Existing”, as described in 
“Managing fields” above. Next, bring up the Rechain Tool. Click the Properties button in 
the tool. This will bring up the Flexible Properties dialog, shown in Figure 28. 

 

Figure 28 - The flexible properties dialog 

We can set the properties for the new line created by the tool, the stations moved, or both. 
To view the property settings for lines or stations, choose from the drop-down list in the 
top-right. If a property is not listed in this dialog box, then it will remain unchanged by 
the tool. In this case, we would choose “Lines” from the drop-down list at the top, and 
choose the “Existing” property from the drop-down list on the left. This will ensure that 
affected line segments are given the “Existing” property. 

Click OK to return to the Rechain Tool, and make some changes. Presumably the 
properties are being set behind the scenes, but we can’t see what’s been marked. This is 
discussed in the next section. 
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Displaying properties 

There is little point in marking properties if we can’t see what’s been marked. To change 
the way that a field is visualized, choose Manage Fields from the Tools menu. The 
Manage Fields dialog box, shown in Figure 29 is displayed. 

 

Figure 29 - The Manage Fields dialog 

To turn field visualization on or off, simply check or uncheck the box to the left of the 
field description. To change visualization options for a particular field, choose the field 
from the list and click the Options button. The Options dialog is useful for two reasons. 
First, if you forget what the reference name for a field is, you can check it here. Second, 
you can change the visualization options for a field. 

To change visualization options, select a field from the list and click the Visualization 
button in the bottom-left corner of the Options dialog. Initially it looks pretty empty, as 
shown in Figure 30. 

 

Figure 30 - An empty visualization dialog 

Visualization options can be applied to points and/or lines. Continuing the example 
above, suppose we want to mark existing line with a green highlight. First, in the Manage 
Fields dialog, choose the “Existing” property from the list and click Options. Now click 
the Visualization button. Choose “Lines” from the drop-down at the top of the dialog box. 
The dialog box should change as shown in Figure 31. 

 21



 

Figure 31 - Line visualization options 

Choose green from the Colour drop-down. In this case, we actually want the line 
segments to be green always if they have the “Existing” property. Set the radius to 3 mm 
or so. Any section of line marked with the existing property should now look like Figure 
32. 

 

Figure 32 - A section of marked line 

We have used the simplest possible set of rules for field visualization, but the rules can be 
much more complex. Suppose we wanted to visualize hole depth. Let’s set up hole depth 
so it’s shown as a circle with radius depending on the depth. We assume that you have 
already created a field called “Hole depth” with data type “double”, and that you have 
marked some sources with their hole depth. Next, in the Manage Fields dialog, choose 
the “Hole depth” property from the list and click Options. Now click the Visualization 
button. Choose “Points” from the drop-down at the top of the dialog box. The dialog box 
should change as shown in Figure 33. 

 

Figure 33 - Point visualization options 

Set the symbol to “circle always”. Set the colour to orange “always”. For the radius, 
make the changes shown in Figure 34. 
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Figure 34 - A variable radius 

These rules are evaluated from top-to-bottom. The result is that the radius of the circle 
depends on hole depth, as shown in Figure 35. Of course, the actual threshold values for 
hole depth will depend on the range of your values. The same trick can be used to make 
symbol or colour dependent on a property’s value. 

 

Figure 35 - Hole depth visualization 

Filtering with properties 

Using properties, it is possible to choose which shots are included in a generated 
template. This would be useful, for example, if you were using more than one shooting 
method in a project. In this case, you might want to shoot one set of shots with Patch 
“A”, and another set with Patch “B”. Suppose the majority of shots use Patch “A”, and 
only a few use Patch “B”. Then you might mark the latter with a Boolean property, say, 
“Uses Patch B”. When it comes time to generate scripts, click the Filter button in the 
bottom-left corner of the Script Wizard. This will bring up the Filter dialog box, shown 
in Figure 36. 

 

Figure 36 - The filter dialog 
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To modify the filter, make a selection from the highlighted drop-down list. In the 
example, we would select “Uses Patch B”. The result is shown in Figure 37. The default 
rule, “is true” is exactly what we want, so no further changes are necessary. 

 

Figure 37 - A simple filter 

For the second script file, we would again apply a filter, but this time we would modify 
the rule to read “is false” instead. 

Equation constraints 

If you are filtering an “integer” or “double” field, one of your filter options is “x satisfies 
y”. The field to the right must contain an equation in terms of x, where the variable x 
stands for the value of the field for each station. The following symbols can be used: 

const constant value (e.g. 1, 2, 3, 3.14) 
x field value 
- negative value 
+ addition 
- subtraction 
* multiplication 
/ division 
% modulus (remainder) 
< less than 
> greater than 
<= less than or equal to 
>= greater than or equal to 
= equal to 
!= not equal to 

For example, the equation “x % 2 = 0” will select all the stations with an even field value. 
The equation “x % 2 = 1” will select all the stations with an odd field value. 

Grids 

Grids in DirectAid are map layers, and can also be used to guide cursor movements. They 
fall into three basic categories: 
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• Regular grids are a series of regularly spaced lines in some coordinate 
system. UTM grids and latitude/longitude grids are examples of regular 
grids. Project grids are a special case of regular grids. 

• Regional grids are usually specific to a particular region. They generally 
have more structure than a regular grid, and may be based on actual 
surveyed points. The Dominon Land Survey (DLS) and National 
Topographic System (NTS) are examples of Canadian regional grids. 

Except for the project grid, all grids are created by right-clicking in the blank area of the 
layer view and choosing New/Grid Layer from the context menu. The first page of the 
New Grid wizard asks what type of grid you would like to build. Depending on the type 
of grid you specify, the following pages will ask for more detailed information. 

Project grids are created by right-clicking on a project in the layer view and choosing 
New/Grid Layer from the project’s context menu. DirectAid will create the grid as a child 
layer of the project. By default, the grid spacing is equal to the line spacing. 

Project grids 

Project grids are a special case of regular grids where the grid spacing is some multiple of 
the line spacing. To change the multiplier, right-click on the grid layer and choose 
Properties from the context menu. The Properties dialog box contains two tabs: one with 
properties specific to the project grid, and the other with line styles for the grid. The 
General tab of the project grid properties dialog box is shown in Figure 38. 

 

Figure 38 - Project grid properties 

Using the General tab, you can turn on/off the receiver grid and the source grid, and also 
adjust the line spacing divider in each direction. By adjusting the divider, you can put 
additional grid lines between project lines. This is useful, for example, for accurately 
interpolating lines. For more information on using the project grid to guide design work, 
see “Project grids” on page 25. 

Regular grids 

To build a regular grid, right-click in the blank area of the layer view and choose 
New/Grid Layer from the context menu. On the first page of the New Grid wizard, 
choose Basic Grid. Click Next. The following three pages are the standard unit, datum, 
and coordinate system pages. It will be easiest to build the grid if you select a unit which 
is appropriate to the grid spacing. For example, if you are building a 1 km UTM Zone 
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10N grid using the NAD27 datum, choose “Kilometer” as your linear unit, “NAD27” as 
your datum, and “UTM Zone 10N” as your coordinate system. 

The last page contains options specific to a regular grid. The basic version of this page is 
shown in Figure 39. 

 

Figure 39 - Basic options for a regular grid 

This makes it easy to create the most common type of grid. In some cases, you may want 
to create a more complex grid. This can be done by checking Advanced options in the 
lower-left corner of the page, which yields the page shown in Figure 40. 

 

Figure 40 - Advanced options for a regular grid 

On this page, you are asked to specify an included point and one or more sets of line 
parameters. Each set of line parameters defines a set of regularly spaced parallel lines. 
The included point is the point through which one line from each set passes. 

When you have set parameters for the grid, click Finish to continue to the final step in 
creating a grid. In this step, the New Grid wizard disappears and the Move Grid tool 
(discussed in greater detail on page 29) is activated. Use the Move Grid tool to define an 
area over which the grid is valid. When you have defined the grid area, close the Move 
Grid tool. 

DLS grids 

The Dominion Land Survey is the method used to divide western Canada into one square 
mile sections. It is the dominant survey method for the prairie provinces, but is also used 
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in parts of British Columbia. Each section (Figure 41) is further divided into 16 legal 
subdivisions (Figure 42). 

 

Figure 41 – The DLS grid 

 

Figure 42 – Legal subdivisions

To use a DLS grid in DirectAid, you will require additional third-party “grid” files which 
define the northeast corner of each section. Currently, the only files which are supported 
by DirectAid come from Terra Management. Several versions of the grid are available, so 
if you are interested in purchasing a copy, please contact us first. If you use another set of 
files and would like to see these supported by DirectAid, please let us know. 

Terra Management offers several versions of the DLS grid, including ATS 2,2, ATS 2.6, 
ATS 3.1, ATS 3.2, MTS, and STS 1.0. These are usually stored in separate folders. To 
use these files in DirectAid, you will need to copy these folders into a folder called “dls” 
in your DirectAid program folder. Your directory structure should look something like 
Figure 43. 

 

Figure 43 – DLS folders 

The names of the individual DLS folders will be used by DirectAid to identify each grid, 
so it is worth spending a moment to make them look nice. Once the data is in the right 
place, you are ready to use DLS grids in DirectAid. 

To build a DLS grid, right-click in the blank area of the layer view and choose New/Grid 
Layer from the context menu. On the first page of the New Grid wizard, choose DLS 
Grid. Click Next. The following page asks which DLS grid you would like to use. The 
list is populated with the names of sub-folders in the “dls” folder. Choose a grid version 
and click Finish to continue to the final step in creating the grid. In this step, the New 
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Grid wizard disappears and the Move Grid tool (discussed in greater detail on page 29) is 
activated. Use the Move Grid tool to define an area over which the grid is valid. When 
you have defined the grid area, close the Move Grid tool. 

By default, DLS grids are drawn down to the section level. By right-clicking on the grid 
in the layer view and choosing Properties, you can change drawing and labeling options 
for the grid. 

NTS grids 

The National Topographic System of Canada provides topographic map coverage of 
Canada. The NTS grid describes the boundary of 1:250,000 (e.g. 82J) and 1:50,000 (e.g. 
82J14) map sheets. In addition, the system has been extended by dividing each 1:50,000 
map sheet (Figure 44) into 12 lettered “blocks” (Figure 45) and 100 numbered “units” 
(Figure 46). The boundaries of older NTS map sheets were defined using the NAD27 
datum; newer map sheets are defined using the NAD83 datum. 

 

Figure 44 - The NTS grid 

 

Figure 45 - The lettered 
sub-grid 

 

Figure 46 - The numbered 
sub-grid

To build an NTS grid, right-click in the blank area of the layer view and choose 
New/Grid Layer from the context menu. On the first page of the New Grid wizard, 
choose NTS Grid. Click Next. The following page is the standard datum page, except that 
it has been restricted to NAD27 and NAD83. Choose a datum and click Finish to 
continue to the final step in creating the grid. In this step, the New Grid wizard disappears 
and the Move Grid tool (discussed in greater detail on page 29) is activated. Use the 
Move Grid tool to define an area over which the grid is valid. When you have defined the 
grid area, close the Move Grid tool. 

By default, NTS grids are drawn down to the 1:50,000 map sheet level. By right-clicking 
on the grid in the layer view and choosing Properties, you can change drawing and 
labeling options for the grid. 

Snap to grid 

In many tools, it is possible to constrain cursor motion to points on a grid by holding the 
Ctrl key in the middle of an editing operation. The following series of pictures shows 
snap-to-grid being used in combination with the Rechain Line tool to move a portion of 
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the line exactly halfway between two theoretical line locations. In this case, we are using 
a project grid (see “Project grids” on page 25) with the spacing divider for receiver lines 
set to 2. 

  

Note that a small “snap-to-grid” cursor appears at the grid point when the Ctrl key is 
held. This is where the vertex will actually be created. 

Using vector layers as grids 

In addition to “native” grid layers, it is also possible to use a vector layer as a grid. To do 
this, right-click on the vector layer in the layer view and choose Use As Grid from the 
context menu. The cursor should now snap to vector layer objects as well as grids when 
you hold the Ctrl key. To stop using the vector layer as a grid, right-click on the vector 
layer in the layer view and choose Use As Grid again from the context menu. 

By using a vector layer as a grid, the snap-to-grid feature can be used to rechain the lines 
of a project to follow lines in a vector layer. For example, you may have received a DXF 
file detailing the location of existing trail. In this case, you could load the DXF into 
DirectAid, choose Use As Grid from the new layer’s context menu, and then switch to the 
Rechain Lines tool. By holding the Ctrl key while choosing points for the rechained line, 
you can constrain these points to lie along a grid—in particular, the DXF file you just 
read in. 

Moving grids 

When you initially create a grid layer, you will need to define an area over which the grid 
is drawn. This rectangular area is defined using the Move Grid tool. Grid boundaries can 
also be modified after the grid has been created by right-clicking on the grid in the layer 
view and choosing Move Grid from the context menu. This will activate the Move Grid 
tool. 

If a bounding box has not already been defined for the grid (for example if you have just 
created the grid), then the grid will not be visible in the map view. You can make the grid 
visible by clicking and dragging with the left mouse button in the map view. This will 
define a box with one corner at the point where you press the mouse button, and the 
opposite corner where you release the mouse button. If you do not see the grid inside this 
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box, the most likely cause is that your grid spacing is too large—there are no grid lines 
within the box. If this is not the case, double-check the units, datum, coordinate system, 
and grid spacing (paying particular attention to the units used to define the spacing), and 
try the Move Grid tool again. 

If a bounding box has been defined for the grid, then there are two ways to use the tool. 
The first is to click and drag in the map and redefine the bounding box. The second is to 
click and drag on the vertices of the existing box to adjust it. When you have finished 
setting the grid’s bounding box, close the Move Grid tool. 

Reports 

In addition to the ability to print maps directly to a printer (see “Printing and Print 
Preview” on page 86), DirectAid features flexible reporting based on the popular Python 
programming language (www.python.org). We have chosen to use Python because it is 
easy to learn and has tremendous community support. 

Our goal for reporting in DirectAid has been to give the user complete control over how 
the information stored in the workspace is manipulated and presented to build the report. 
To achieve this, we have given Python complete access to workspace data. Reports are 
generated entirely using Python scripts, which in turn make use of open source third-
party libraries to incorporate elements such as images and PDF documents in the report. 

This may sound very complex to users who are not themselves programmers. However, 
we have included a few basic reports which will suffice for most users’ needs. As you 
will see in the following section, applying these reports is very easy. If you find that these 
reports do not meet your requirements, please let us know and we will help you create 
what you are looking for. 

Additional information for users who are interested in writing their own reports can be 
found in “DirectAid Extensions to Python” on page A-1. 

Applying reports 

Active layers 

Because a single workspace may contain multiple projects, before you can generate a 
report you will need to tell DirectAid which project to report on. This is done by setting 
an “active layer”. Active layers are marked as bold in the layer view, as shown in Figure 
47. 

 

Figure 47 - An active project 
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To set an inactive project as the active layer, right-click on the project in the layer view 
and choose Active Layer from the context menu. If the menu item is checked, then the 
layer is already active. 

Each project has one “active” midpoint layer. The active midpoint layer is the focus of 
attention in reports which include subsurface plots such as fold. If a report includes a 
colour scale, this scale refers to the active midpoint layer. If a report manipulates the 
current midpoint plot (for example, changing it to a detailed offset distribution plot), then 
it is the active midpoint layer which will be affected. 

The active midpoint layer is shown in bold in the layer view. To set a midpoint layer 
active, right-click on the midpoint layer in the layer view and choose Active Midpoint 
from the context menu. If the menu item is checked, then the midpoint layer is already 
active. If a midpoint layer is active and visible, you should see a midpoint layer legend in 
lower-right corner of the map view. 

Generating the report 

Once you have selected an active project and an active midpoint layer, you can generate 
any report with those two layers as the “target” of the report. First, switch to the report 
view by clicking on the “Reports” tab at the bottom of the layer view. This will display a 
list of available reports, as shown in Figure 48. 

 

Figure 48 - The report view 

To get a description of the report, hold the mouse cursor over the report for a moment. 
This will display a balloon including the name of the report, a description, and an image 
showing a typical report, as shown in Figure 49. 

 31



 

Figure 49 - A report description 

To generate a report using the current active layers, right-click on the report and choose 
Run from the context menu. The first time you generate a report, it may take a few 
moments to complete. When the report is complete, it will open a window showing you 
the generated report. If the report is a PDF, DirectAid will open Acrobat Reader with the 
completed report. 

If the report generates errors, DirectAid will bring up an error dialog box like the one 
shown in Figure 50 below. 

 

Figure 50 - The report error dialog box 

Although the diagnostic information displayed is really only useful to those who are 
familiar with the Python programming language, the two most common causes of these 
errors are: 

• No active project has been defined. Right-click on the project and check 
that Active Layer is checked in the menu. If it is not checked, click on 
Active Layer. 

• The file being generated by the report is already open. This can happen if 
you’ve generated the report once before and have not closed that window. 
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Reports included with DirectAid 

As mentioned above, several reports are included with DirectAid. These reports are 
intended to take care of basic plotting and reporting needs, and as samples for more 
advanced users who wish to build their own reports. The following table lists the reports 
included with DirectAid: 

Report Name Description 
Design Summary A tabular PDF report giving: 

• Parameter summary 
• Source and receiver summaries 
• Crossline patch summary 

Project Report A package including the design summary, the fold 
histogram, and subsurface plots. 

Simple Plot Generates a PDF with a map of the current view and 
labels. 

Subsurface Plots A package of plots in a single PDF on letter size paper. 
Camera and midpoint layer settings are modified to 
yield the following output: 

• Fold plot 
• Offset-squared gap deviation 
• Offset-squared distribution (detail) 
• Azimuth gap deviation 
• Azimuth distribution (detail) 
• Midpoint distribution (detail) 
• Offset-azimuth distribution (detail) 

In addition to these reports, several histograms are included: 

Histogram Name Description 
Fold Histogram A histogram showing the distribution of fold in 

subsurface bins. 
Offset-Squared Gap 
Deviation 

A histogram showing the distribution of offset-squared 
gap deviation in subsurface bins. 

Azimuth Gap 
Deviation 

A histogram showing the distribution of azimuth gap 
deviation in subsurface bins. 

Offset-Azimuth 
Distribution 

A two-dimensional histogram showing the distribution 
of offset and azimuth in subsurface midpoints. 



Scripts 

Building scripts 

To build scripts for a project, right-click on the project in the layer view. From the 
context menu, choose New and then Script layer. This will bring up a sheet asking for 
details on the shooting method. Five shooting methods are currently available. To choose 
between these methods, select from the drop-down list in the bottom-right corner of the 
sheet, shown in Figure 51. 

 

Figure 51 - Shooting methods 

Annulus shooting 

An annulus shoot is defined by a minimum and maximum radius from the source. If the 
minimum radius is set to “0.0”, then this is a circle shoot, including every receiver out to 
the maximum radius. 

By clicking the Advanced parameters checkbox at the top-left of the page, you can 
change two additional parameters. The annulus can be offset from the source by a 
specified distance in the inline and crossline directions. This is not generally 
recommended, but is included for advanced shooting methods. 

Patch shooting 

A patch shoot is defined by a certain number of lines and a certain number of stations on 
each of those lines, usually centered on the source point. Options for the patch shoot are 
shown in Figure 52. 

 

Figure 52 - Patch shooting options 

In DirectAid, the patch shoot is actually defined by a certain number of lines and a range 
of inline distances, centered on the source. Usually this is similar to specifying a number 
of stations on each line (simply multiply the number of stations by the interval to get the 
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inline patch size), but the new method deals very well with gaps in lines and extra 
stations. 

You also have the option to roll crossline or roll inline. Roll simply means that when the 
patch hits the edge of the survey, it drops lines or stations to remain centered on the 
source. You will usually create patches with both of these options enabled. The most 
common case where you would not use inline roll is if you are shooting with every 
station on a line live. Similarly, you will likely disable crossline roll only if you are 
shooting with every line live. 

By clicking the Advanced parameters checkbox at the top-left of the page, you can 
change several additional parameters, as shown in Figure 53. 

 

Figure 53 - Advanced patch shooting options 

If there are gaps in the line, the patch will probably include fewer stations than specified. 
If there are extra stations in the line, this will actually result in more stations in the patch 
than you might have expected. This is done to maintain a consistent offset range in the 
patch, since the patch would not extend to long offsets without additional stations. If you 
would like to restrict the patch so it will never use more than the specified number of 
stations, check the box labeled “Limit number of stations”. 

There are two methods of offsetting a patch. First, you might pretend that the source was 
actually in a different place, and generate patches as normal from there. This is known as 
source offset, and can include inline and crossline components, measured in metres. 
Alternatively, you might shoot the patch with the source in its true position, but rather 
than selecting the same number of receiver lines on either side of the source, you might 
select more on one side. This is known as a crossline receiver offset, and is given as a 
number of receiver lines. 

Finally, in general, it is recommended that you shoot an orthogonal survey with an even 
number of lines in the patch. Assuming your source lines are not coincident with 
receivers, you should also be shooting with an even number of stations in the patch. 
However, if you choose to shoot with odd numbers in these circumstances, there is some 
uncertainty as to which side of the source the “extra” receiver line or station should go to. 
This is resolved by the options labeled “Odd line/station goes to”. 
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When you have entered all the parameters for the script, click Finish to complete the 
operation. DirectAid will generate the scripts, add them to the project in the layer view, 
and the View Templates tool will be activated. 

Rectangle shooting 

A rectangle shoot is defined by an inline (parallel to the receiver lines) and crossline 
(perpendicular to the receiver lines) patch size. By default, the patch is centered on the 
source. Receivers within the box are included in the patch, and those outside the box are 
not. 

If you choose to use a rectangular patch, there are a couple of related issues you should 
be aware of. First, the receivers included from a single line may not form a single 
contiguous range. That is, there may be a “gap” in the patch on a given line, if the line 
passes out of the patch and back into it. Second, the patch may include only a small 
number of stations from a line near the boundary of the patch, if the line lies mostly 
outside the patch, but passes into it briefly. These two situations are pictured in Figure 54 
and Figure 55. 

 

Figure 54 - A gap in a rectangular patch 

 

Figure 55 - An accidental inclusion 

By clicking the Advanced parameters checkbox at the top-left of the page, you can 
change two additional parameters. The rectangle can be offset from the source by a 
specified distance in the inline and crossline directions. This is not generally 
recommended, but is included for advanced shooting methods. 

Swath shooting 

A swath shoot is similar to a patch shoot, except that more than one source swath can be 
associated with a single patch. A swath shoot may be either full-patch—in which case the 
entire patch is included in each template—or half-patch—in which case only half the 
patch is included in each template. The two types of swath shoot are pictured in Figure 56 
and Figure 57. 
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Figure 56 - Full-patch swath shoot 

 

Figure 57 - Half-patch swath shoot

The half-patch swath shoot can be used to generate scripts for the “ping-pong” shooting 
method, in which two sets of vibrators are used—one shooting from one side of the 
patch, and the other from the opposite side. 

Numbering the swaths 

Swath shooting in DirectAid is a two-step process. First, you will need to number the 
source swaths. Second, you will create a script using these swaths. This has been done to 
give users extra flexibility in cases where the definition of the source swaths is not 
completely obvious—for example, when stub receiver lines are involved. 

To number the source swaths, right-click on the “Sources” layer in the layer view. From 
the context menu, choose either Number Full Swaths or Number Half Swaths. A full 
swath is defined as all the stations between two adjacent receiver lines; a half swath is all 
the stations which are closest to a single receiver line. These are pictured in Figure 58 and 
Figure 59. 
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Figure 58 - Full swaths 

 

Figure 59 - Half swaths 



The decision to use full swaths or half swaths depends on how many receiver lines and 
source swaths are in your patch: 

 Odd number of lines Even number of lines 
Odd number of swaths Use half swaths Use full swaths 
Even number of swaths Use full swaths Use half swaths 

Note that if you are using a half-patch swath shoot, you’ll need to use the number of lines 
in the complete patch, that is, twice the actual number of lines in the patch, when doing 
this calculation. 

Automatic swath numbering sets the “_Swath_Number” property for each source, based 
on survey geometry. In some cases, this may be a little different from what you expect. 
Take, for example, the region shown in Figure 60. 

 

Figure 60 - An incorrectly numbered swath 

Here, we are looking at a stubbed receiver line. Line 36 runs from east to west. The main 
line is the north one, but at the west end of that line, a stub has been added to the south. 
When calculating swath numbers, DirectAid ignores the smaller stub line, except where it 
finds no intersection with the main line. In this case, you can see that it has arguably mis-
numbered a few shots on the west-most source line. We can fix these manually by 
changing the “_Swath_Number” property for those stations. 

Creating the script 

Once you’re satisfied with the swath numbering, you’re ready to create scripts. Right-
click on the project in the layer view. From the context menu, choose New and then 
Script layer. From the list of shooting methods, choose either “Full-Patch Swath Shoot” 
or “Half-Patch Swath Shoot”. 
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The parameters on the left side of the window define the size of the patch, as well as roll. 
If you are using a half-patch swath shoot, the number of lines is the actual number of 
lines which will be live, and not the total number of lines in the “full” patch (which is 
twice that number). 

On the right side of the window, both swath shooting methods ask for “Number of 
swaths” and “Swath adjustment”. The first parameter is the number of adjacent swaths 
which will use the same receiver patch. For example, Figure 56 shows a patch with 3 
swaths. By default, swaths 0  through 1−N  will share the same receiver patch, as will 
swaths  through , and so on. You can use the swath adjustment to bump these 
ranges forward or backward. 

N 12 −N

In addition, the half-patch swath shoot needs to know which half of the patch you want to 
use for this script. If you’re writing scripts for ping-pong shooting, each source will be 
shot twice—once by each set of vibrators. One set of vibrators will shoot with the swath 
at the high end of the patch, and one with the swath at the low end. 

Viewing scripts 

It is highly recommended, after creating or importing scripts, that you take a moment to 
check them using the View Templates tool. This tool is activated automatically after 
creating scripts, but can also be activated by choosing right-clicking on a script layer and 
choosing View Templates from the context menu. The tool is shown in Figure 61. 

 

Figure 61 - Viewing templates 

To use the View Templates tool, first select a script layer from the drop-down list at the 
top. The buttons at the bottom of the tool are used to step through sources in the parent 
project: 

 Go to first template 
 Play backward 
 Step backward 
 Pause 
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 Step forward 
 Play forward 
 Go to last template 

After selecting a template, usually the first thing you will do is to go to the first template. 
Now, press the “play forward” button. DirectAid will automatically step through 
templates. To control the speed of the animation, use the slider in the tool. With the slider 
centered, the animation is paused. To the left, the animation moves backward; to the 
right, it moves forward. If you have a mouse wheel, you can use it to zoom into the map 
and pan around while the animation proceeds. This can be used to check possible 
problem areas in greater detail. 

Finally, you can check the template for a particular source point by clicking on that 
source in the map view. The animation, if running, will be paused. 

Reading/writing script files 

Reading 

To read script files in SPS, ARAM project, or I/O binary format, right-click on the 
project in the layer view. From the context menu, choose Import and then Script layer. 
Using the file dialog, select the script files to be imported, and click Open. The scripts 
will be added to the project in the layer view. As always, it is a good idea to view 
templates after importing a script file. 

Writing 

To write script files in SPS, ARAM project, or I/O binary format, right-click on the script 
in the layer view. From the context menu, choose Export. In the Save As dialog, choose 
the format of the script at the bottom, enter a name, and then click Save to complete the 
operation. Depending on the format of the script file you are writing, DirectAid will ask 
for additional information needed for export. 

For SPS files, DirectAid will need to know whether you would like to include the line 
label as a prefix to the station number. By default, this is not selected. You will also be 
asked to specify the maximum number of templates per file and overlap between files. 
The default value of 3600 templates per file should be sufficient for most systems. 
Following this page, you will find the three coordinate system pages. Although the SPS 
script file itself doesn’t require coordinate system information, the header of the file does. 
You should use the same selections here that you use when writing out the SPS point 
files. 

For ARAM project files, you will be asked what software version will be used to read the 
file. This refers to the ARAM software version. If you are using integer line labels and 
station numbers, as is usually the case, then all three options are equivalent. Otherwise, 
you will need to find out what version of software is being used by the crew. Following 
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this page, you will find the three coordinate system pages. This is the coordinate system 
that will be used when writing source and receiver stations to the ARAM project file. 

I/O binary scripts do not require any additional parameters. 

Merging scripts 

In most cases, you will use a simple script to shoot a project. In some cases, however, 
you may want to combine several simple scripts to build a more complex script. For 
example: 

• To make efficient use of available equipment, you might use different 
patches in different parts of a survey. 

• You may want to estimate the effect of using smaller charges in part of the 
survey. One way of doing this is to shoot the small-charge shots with a 
small radius patch, and the remainder of the shots with a larger radius. 

In both these scenarios, you will first need to generate one “basic” script which includes 
every shot in the project, and a second “modified” script which includes only those shots 
you want to replace with a modified patch. To shoot only part of the survey, you will 
need to mark some of the shots using flexible properties (see “Setting properties” on page 
19), and then create a script only for the marked shots (see “Filtering with properties” on 
page 23). 

Check the scripts using the View Templates tool to ensure that the “modified” script is 
defined only for the marked shots (when you click on unmarked shots, the patch should 
not appear). Then drag the “modified” script onto the “basic” script in the tree view. The 
“basic” script should be highlighted just before you release the left mouse button. 

When you release the button, you will be asked to confirm the merge operation. Click OK 
to continue. The merge process will replace individual shot templates in the target script 
if they exist in the source script. 

Sorting scripts 

When scripts for a large project are split across multiple files, it can be helpful for the 
recording crew if the scripts are sorted in the order they will be shot. Although DirectAid 
has no way of knowing what the actual shooting order is, you can use the simple script 
sorting options to approximate it. To sort scripts, right-click on the script in the layer 
view and choose Sort Script from the menu. This will open the dialog shown in Figure 
62. 



 

Figure 62 - Sorting scripts 

Using the sort tool, you can sort either by source line or by source swath. When sorting 
by source line, templates on the same source line will be arranged in order of shot 
number. 

Before sorting by swath, you must number source swaths, as described in “Numbering 
the swaths” on page 37. 

When sorting by swath, templates in the same swath will stay in their original order. This 
means you can arrange templates within a swath by sorting first by source line, and then 
by swath. 

Duplicating scripts 

It is sometimes handy to have an extra copy of a script, but with a few shot templates 
changed. For example, you may want to merge a smaller script into a larger one, but 
retain a copy of the originals. To duplicate a script, right-click on the script in the layer 
view and choose Duplicate from the menu. This will create a copy of the script layer that 
you can change without affecting the original. 

Copying scripts between projects 

It is possible to copy a script from one project to another. To copy a script, drag it from 
the first project, and drop it on the second project in the layer view. This will create a 
lightweight duplicate of the script layer in the second project. 

Shooting a Script 

To shoot a script, right-click on the script and choose Shoot from the context menu. This 
will show the Midpoint Wizard. The first page of the wizard is used to specify options for 
generating a midpoint given a source and receiver. At this time, you may choose to use 
elevation data from the stations, or not. For more information on this option, see 
“Elevations in shooting” below. 
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In most cases, you will not use station elevation information. This will result in midpoints 
which are located halfway between the source and the receiver. To continue to the second 
page of the wizard, click Next. This will display the Bin Options page, shown in Figure 
63. 

 

Figure 63 - Bin options 

The information in this dialog box is determined automatically from the project 
geometry. In some cases, you may need to “tweak” the bin azimuth or position in order to 
keep midpoints better aligned with the bins. In general, your bin size will be determined 
by design parameters. When you have verified the values and made any corrections, click 
Finish to shoot the script using the parent project. 

When midpoint calculations are complete, a new “midpoint” layer will appear at the top 
of your project sub-tree. You will probably want to drag this layer to a position below the 
stations so you can view stations on top of the subsurface plots. To show or hide the new 
plot, click on the check box next to the layer in the layer view. 

Each project has one “active” midpoint layer. This midpoint layer is shown in bold in the 
layer view. To set a midpoint layer active, right-click on the midpoint layer in the layer 
view and choose Active Midpoint from the context menu. If the menu item is checked, 
then the midpoint layer is already active. If a midpoint layer is active and visible, you 
should see a midpoint layer legend in lower-right corner of the map view. 

Elevations in shooting 

On the first page in the Midpoint Wizard, you can choose to include station elevation 
information in the calculation of midpoints, as shown in Figure 64 below. 

 

Figure 64 - Midpoint options 

Usually, the reflector is assumed to sit so far below the source and receiver that the 
reflection midpoint is halfway between the two. However, in topographically complex 
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areas, and with shallow reflectors, it is sometimes useful to take into account the relative 
elevations of the source, receiver, and reflector. 

A note of caution 

Before you choose to include elevation information in the calculation of midpoints, be 
sure that you understand how your data will be processed. This is important because 
when we generate midpoint statistics such as fold, a big part of what we’re trying to 
decide is how robust the data will be in processing. If the algorithm we use to calculate 
statistics is not matched with the algorithm used in processing, the results may not be 
meaningful. 

There are two migration methods typically used in seismic data processing: pre-stack 
migration and post-stack migration. In pre-stack migration, the actual elevation of the 
stations may be taken into account. In post-stack migration, the traces are assumed to lie 
at the midpoint between the source and receiver. Because of this, it may be useful to take 
elevations into account if pre-stack migration is used, but not if post-stack migration is 
used. 

Onward 

To use this feature, you will need to have elevations assigned to your sources and 
receivers. At the moment, the only way to do this is if they are specified in the input file 
when the project is imported. In the coming year, we will be working on ways to assign 
station elevations from an imported digital elevation model (DEM). To make it easier to 
check if your elevations are assigned correctly, we have added a third field, elevation, to 
the position displayed when you hold the mouse over a station. 

The reflector elevation uses the same coordinate system as the station elevations. If your 
station elevations are given as decimeters above the WGS84 ellipsoid, for example, then 
your reflector elevation will need to be given in the same coordinate system. 

Let  and  be the height of the source and receiver above the reflector, and  and 
 the 2-dimensional source and receiver positions. Then the midpoint position  is 

calculated using the following pair of equations, which assume a flat reflector: 

sz rz sp

rp mp
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Subsurface bin statistics 

By default, a new midpoint layer shows a fold plot. To change the plot, right-click on the 
midpoint layer. The context menu displays several plot choices. Not all of these are 
exclusive. For example, it is possible to view the fold plot with midpoint distribution on 
top. 
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Single-valued plots 

The fold plot is an example of a single-valued plot. You can have only one single-valued 
plot active in a midpoint layer at one time, since this is used to generate the colour 
background for the plot. To turn off the plot, select it a second time from the context 
menu. 

To show the value of each bin in the map view, select Bin values from the midpoint layer 
context menu. The value will only show up at small map scales, as with detail plots 
(described below), and will automatically disappear when you zoom out. 

Detail plots 

The midpoint distribution is an example of a detail plot. Detail plots can be shown on top 
of single-valued plots. Detail plots do not show up at large map scales. To change the 
threshold scale at which detail plots appear, go to Preferences in the View menu, then 
select the Project Layers tab. Like single-valued plots, they can be turned on and off by 
selecting them in the context menu. 

Fold 

The Fold plot shows the total number of midpoints in each bin. 

Offset and azimuth distribution 

The Offset and Azimuth Distribution plots are detail plots which shows the distribution of 
source-receiver offsets and azimuths for midpoints contributing to each bin. Bars in both 
plots have a length proportional to the offset of the midpoint. In the case of the azimuth 
plot, this results in a “striped” appearance to the bars, since midpoints with a given 
azimuth may have several different offsets. Bars on the inside of the azimuth distribution 
plot are drawn with the highest redundancy colour. Redundancy ranges are controlled in 
the detail plot options. 

For 3D surveys, the Offset-Squared Distribution is more important than the offset 
distribution. This is drawn with bins equally spaced in offset-squared, but with a height 
proportional to offset. 

Offset and azimuth gap deviation 

The Offset and Azimuth Gap Deviation plots represent the “smoothness” of the offset and 
azimuth distributions as a single value which can be viewed as a colour plot at a large 
scale. 

To calculate this value, offsets and azimuths are arranged in increasing order. A list is 
then made either of the difference in offset-squared or the difference in azimuth between 
adjacent values. The homogeneity is the standard deviation of the differences, normalized 
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by the maximum possible deviation. For a perfectly even distribution, the homogeneity 
would be 0%, while the most uneven possible distribution would give 100%. Typical 
values of offset gap deviation are 4% to 20%, and for azimuth gap deviation 0% to 16%. 

For 3D surveys, the Offset-Squared Gap Deviation is more important than the offset gap 
deviation. This is calculated from a list of gaps in offset-squared, and takes into account 
the expected surplus of long offsets compared to short offsets. 

Offset and azimuth gap maximum 

The Offset Gap Maximum and Azimuth Gap Maximum are single-valued plots which 
show the largest offset and azimuth gap, respectively. 

Midpoint distribution 

The Midpoint Distribution is a detail plot which shows the position of each midpoint 
within the bin. Midpoint dot size is controlled in the detail plot options. 

Subsurface plot options 

Many options can be set for subsurface plots. To change plot options, right-click on the 
midpoint layer and choose Properties from the context menu. 

The Colours page controls the colour scale used for single-valued plots. The colour scale 
is formed by interpolating between coloured “pegs”, shown as triangles on the right side 
of the colour bar. Two pegs, one at either end of the scale, are fixed in place and are 
shown as squares. To delete and existing peg, click on the peg and hit the Delete key. To 
insert a peg, double-click to the right of the colour bar where you would like a peg to 
appear. Pegs can be moved by dragging them along the colour bar. The colour of a 
selected peg can be changed by choosing from the colour palette to the right. 

The Line Style page controls the line style used for the bin grid. This page is described in 
the section “Polylines and polygons” on page 74. 

To Plots page contains the minimum and maximum offset, as well as value ranges for 
each of the single-valued plots. The value ranges are shown in a single table. Cells in the 
table can be modified by selecting them and entering a new value, or by double-clicking 
to show an edit box for the value. Note the units for each of the entries, shown in the 
label for each row. The ranges for offset-squared values are displayed as the square root 
of the actual value, so that they are more meaningful for the user. 

Finally, the Detail page controls options for each of the detail plots. To choose a plot, 
select it from the drop-down list in the top-right of the page. 



Duplicating a midpoint layer 

In some cases, you may want to keep two copies of a midpoint layer with slightly 
different plot settings. For example, you may want to look at the same set of midpoint 
data, but with different offset limits. In such a case, it would be wasteful to duplicate all 
of the midpoint data, which is the same for the two layers. To create a lightweight 
duplicate of a midpoint layer, right-click on the layer in the layer view and choose 
Duplicate from the menu. This will create a copy of the midpoint layer that you can 
change without affecting the original. 

Editing a Project 

When a project is imported into DirectAid, the program not only reads the stations, but 
also automatically generates smoothed polylines which represent the survey lines 
themselves. Thus, we have separated the notion of the line from the station. Although 
changes to one will result in changes to the other, so that they remain consistent, it gives 
us additional possibilities for editing. 

Selecting lines and stations 

Map objects can either be selected individually, or all objects within a specified area can 
be selected. 

Selecting individual objects 

To select individual map objects, change to map object selection mode either by choosing 
Objects from the Select menu, or using the toolbar button ( ). The Select Objects dialog, 
shown in Figure 65, will appear. 

 

Figure 65 - Object selection tool 

When your cursor is near an object which can be selected, a circle will appear around the 
crosshairs, as shown in Figure 66, to indicate which object will be selected. Click to 
select the object. To select a range of stations, click on the first station in the range and 
then hold the Shift key while clicking on the last station in the range. To add to an 
existing selection, hold the Ctrl key while selecting. The Ctrl key may be used in 
combination with the Shift key to add a range to an existing selection. 
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Figure 66 - An object marked for selection 

The Select Objects dialog box contains a selection filter. By default, the tool will select 
any object. Using the filter, it is possible to restrict selection to individual stations, salvos 
of stations (all the stations between two line intersections), swaths (all the salvos between 
two line intersections), or entire lines. 

Selecting objects within an area 

To select objects within an area, change to area selection mode either by choosing Area 
from the Select menu, or using the toolbar button ( ). The Select Area dialog, shown in 
Figure 67, will appear. 

 

Figure 67 - Area selection tool 

Click in the map view to define a selection polygon. To complete the selection, double-
click on the last point of the polygon. To cancel selection, choose Clear Area from Select 
Area dialog box. 

The Select Area dialog box contains a selection filter. By default, the tool will select any 
object. Using the filter, it is possible to restrict selection to survey lines, complete salvos 
of stations (all the stations between two line intersections), or individual stations. 

Deleting lines and stations 

Lines and stations can be deleted either in the layer view or in the map view. In the layer 
view, you can right-click on a single line or station, and choose Delete from the context 
menu. 

To delete lines and stations in the map view, select them in the map view as described in 
the section “Selecting lines and stations” above. Once you have made your selection, 
right-click on a selected item and choose Delete from the context menu. If you are 
deleting stations, a section of line underneath the stations will be “broken”. 
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Moving lines and stations 

The first method of editing projects is to drag lines and stations by hand. First, select the 
lines or stations you want to move (see “Selecting lines and stations” above). 

Selection rules in the map view are similar to the rules in the layer view. To select a 
single object, place the cursor near the object. When the cursor is within the hit test radius 
(defined in the Preferences dialog under the View menu), a circle will appear around the 
object, as shown in Figure 68. When you place the cursor near certain objects, such as 
project lines or stations, you may also see a small bubble appear which gives basic 
information about the object. 

 

Figure 68 - The selection circle 

When the selection circle is visible, clicking the left mouse button will select the circled 
layer. Selected layers are drawn with a transparent overlay, as shown in Figure 69. 

 

Figure 69 - Selecting a range of stations 

To select a range of layers, click on the first layer, then hold the Shift key while clicking 
on last layer. To add to an existing selection, hold the Ctrl key while selecting. To add a 
range to an existing selection, hold both the Shift and Ctrl keys and select the range as 
usual. 

To move a selected group of objects, just click and drag the selection using the left mouse 
button. The objects will be translated rigidly in their source coordinate system. When you 
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drag a group of stations, the polyline will be broken halfway between the ends of the 
selection and the next unselected station, as shown in Figure 70. 

 

Figure 70 - Moving a range of stations 

To select a project line, you can either click on the polyline itself (the selection circle will 
snap to the polyline if you are far enough away from the nearest station), or you can 
right-click on a station in the map view to access its context menu. Choose Select line 
from the context menu to select the parent line. A selected line, like any selected layer, is 
drawn with a transparent overlay as shown in Figure 71. To move the line, just click and 
drag it. 

 

Figure 71 - Selecting a project line 

The bingo card 

When dragging a group of stations, it is sometimes useful to constrain movements to 
entire station intervals inline and crossline. As a guideline for station movement, Mustagh 
has developed what we call the “bingo card”, shown in Figure 72. Possible station moves 
are given ratings starting at “1” (not shown in the bingo card). The best position for the 
station is understood to be where it started. From there, crossline moves up to half-way to 
the next line are preferred. A crossline move one box past the half-way point is 
equivalent to a move one box inline and one box crossline. 

To access the bingo card, hold the Ctrl key while dragging a group of stations. This will 
also constrain station movement to the center of bingo card boxes. 
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Figure 72 - The bingo card 

Editing lines 

The second method of editing projects is to edit the polylines themselves. To edit a 
polyline, select the project line using one of the methods mentioned above, then double-
click on the selection. Alternatively, you can right-click on a station in the map view to 
access its context menu, then choose Edit line from the context menu to edit the parent 
line. When you are in editing mode, the polyline will appear with the usual transparent 
overlay, but will also have a thick box at each node of the polyline, and a thin line 
spanning each broken section of the polyline, as shown in Figure 73. 

 

Figure 73 - Editing a project line 

To edit the polyline, you can either click and drag the nodes, or create a new node by 
clicking on an edge of the polyline. As you make changes to the polyline, the project 
stations will follow by projecting themselves perpendicular to the survey azimuth. For 
example, if you are editing a receiver line, each station will be projected perpendicular to 
the receiver azimuth. This ensures that midpoints generated later on will remain in the 
same row or column of the subsurface bins. 

To delete a node, right-click on the node and choose Delete from the context menu. To 
break a line segment, right-click on the segment and choose Break from the context 
menu. All stations on that segment will be deleted. To reconnect the segment, right-click 
and choose Connect from the context menu. Note that stations deleted as a result of 
breaking the line will not be recovered when it is re-connected. 

 51



If you are dragging a node at the end of a project line, it is possible to change the line so 
that one or more stations cannot be projected onto the new line. In this case, the stations 
will become ghosted as long as the mouse button is held down. If you happen to have the 
stations visible in the layer view, you will see their label drawn in gray rather than black. 
As long as the mouse button is held down, these stations remain active, although they are 
not visible. This means that if you drag the endpoint in so that a few stations are ghosted, 
and then drag it back out again, the stations will reappear. When the mouse button is 
released, any ghosted stations are deleted. 

To exit node editing mode, simply select another layer or click on the white background 
of the map to deselect everything. 

Snap to grid 

While dragging a node, it is possible to constrain movement to the inline and crossline 
azimuths for the project. This can be useful for extending the end of a line, for example. 
To turn on the grid, hold the Ctrl key while dragging. 

Rechaining lines 

The best way to move a section of line (and the stations that are on it) to an existing trail 
is using the Rechain tool. To rechain lines in a project, right-click on the project in the 
layer view, and choose Rechain Line from the context menu. 

To use the rechain tool, first click on a line to select it, as shown in Figure 74. This will 
actually only select the part of the line, beginning with the clicked point, which does not 
project onto itself. 

 

Figure 74 - Selecting a line segment 

Next, hold the Shift key. You will notice that with the Shift key held down, the selection 
circle no longer appears when you bring the cursor close to a line. With the Shift key 
held, the rechain tool is ready for you to define a new segment of line. Since this segment 
might overlap other lines, selection must be disabled. 

To define a new line segment, click on the first point of the segment without releasing the 
Shift key. A node will appear at the clicked point, as shown in Figure 75. 
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Figure 75 - Selecting the first point for rechain 

Now click on the second point of the segment. As long as you hold the mouse button 
down, a line drawn between the first and second point will follow you, as shown in 
Figure 76, so you can align it with the existing trail. When you release the mouse button, 
a segment of the original line will be rechained to the new path, as shown in Figure 77. 

 

Figure 76 - Selecting the second point for rechain 

 

Figure 77 - Rechaining a line segment 

Notice that a node remains at the last point clicked. By shift-clicking another new point, 
you can add another node connected to the new segment. Each shift-click adds a new 
segment. Every time you release the mouse button, a segment of the original line is 
rechained and the tool is ready for the next point to be entered. By shift-clicking a series 
of points, the line can be rechained to a complex path, as shown in Figure 78. 
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Figure 78 - Rechaining to a complex path 

The Clear button in the tool can be used to clear the “active” point. This way, you can 
rechain multiple disjoint segments. To de-select the project line, release the Shift key and 
click in the background (when the selection circle is not visible). 

Using the rechain tool, it is possible to rechain line segments rapidly by following the 
procedure above. This procedure is repeated here for clarity: 

1. Click to select a line. 
2. Holding the Shift key, define the new path. 
3. Release the Shift key. 
4. Repeat for other lines. 

Snap to grid 

See “Grids” on page 24 for more information. 

Adding stations to a line 

Stations can be added to a line either by interpolating between existing stations, or by 
adding stations to the end of the line. In either case, you will want to use the Interpolate 
tool. To interpolate stations in a project, right-click on the project in the layer view and 
choose Interpolate Stations from the context menu. 

Interpolating stations 

To interpolate between two existing stations using the Interpolate tool, click on the 
segment of line between the two stations, as shown in Figure 79. 

 

Figure 79 - Selecting a line segment for interpolation 
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With the segment selected, the interpolation tool (shown in Figure 80) will give details of 
the selected range, the measured distance, and number of missing stations. 

 

Figure 80 - The interpolation tool 

By default, the interpolation tool will replace stations based on projected distance. It is 
also possible to interpolate along a path using the total distance by selecting “Use total 
distance” in the drop-down list. To interpolate a different number of stations from what is 
recommended, change the value labeled “Number of stations”. Click Apply to interpolate 
the stations, as shown in Figure 81. 

 

Figure 81 - After interpolating stations 

Extrapolating stations 

The procedure for extrapolating stations is similar to the procedure for interpolating 
them, except that instead of clicking on the line segment between two existing stations, 
you will click on the “tail” of the line which goes just past the last station, as shown in 
Figure 82. In this situation, the interpolation tool will extend the line segment as 
necessary to add the requested number of stations. 
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Figure 82 - Selecting the tail of a line for extrapolation 

Adding a new line 

To add a new line to a project, use the Add New Line tool. Too add new lines to a project, 
right-click on the project in the layer view and choose Add New Line from the context 
menu. 

To begin using the tool, select a line in the map view by clicking on it. The tool options 
dialog will be populated with information about the line you’ve just clicked. Most of the 
values are self-explanatory. Station offset is the distance from the start of the line to the 
first station. 

There are two ways to move ahead from here. If your line labels are integer values, you 
can press and release the Shift key to increment the line number by two. If you have 
selected a line other than the last one, you may need to press and release Shift several 
times. DirectAid will stop incrementing the line number when you have reached an 
unused number. This use of the Shift key should make more sense in a moment. 

If your line labels are not integer values, or if you want to enter a specific line number, 
you can enter a new line label manually. The selected line will be de-selected in the map 
view, but the line parameters will remain unchanged. If you’ve entered the number of an 
existing line, that line will be highlighted and you will not be able to add a new line using 
that number. 

Once you have entered a new line number, there should be no line selected in the map 
view. If you need to adjust any of the line parameters, this is the time. 

Next, hold the Shift key. You will notice that with the Shift key held down, the selection 
circle no longer appears when you bring the cursor close to a line. With the Shift key 
held, the Add New Line tool is ready for you to define a new segment of line. Since this 
segment might overlap other lines, selection must be disabled. 

To define a new line segment, click on the first point of the segment without releasing the 
Shift key. A node will appear at the clicked point, as shown in Figure 83. 
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Figure 83 - Selecting the first point of a new line 

Now click on the second point of the segment. As long as you hold the mouse button 
down, a line drawn between the first and second point will follow you, as shown in 
Figure 84, so you can align it with, for example, an existing trail. When you release the 
mouse button, a segment of the original line will be rechained to the new path, as shown 
in Figure 85. 

 

Figure 84 - Selecting the second point of a new line 

 

Figure 85 - Adding the first line segment of a new line 

Notice that a node remains at the last point clicked. By shift-clicking another new point, 
you can add another node connected to the new line. Each shift-click adds a new 
segment. Every time you release the mouse button, a new segment of line is created and 
the tool is ready for the next point to be entered. By shift-clicking a series of points, a 
new line can be created which follows a complex path, as shown in Error! Reference 
source not found.. 
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Figure 86 - Creating a new line following a complex path 

One thing to note here is that stations are added to the line using chained distance. This is 
not in general the best way to add stations except for a straight line. Usually, if you need 
to add a line which follows a slightly perturbed path, you will want to add the line along 
the straight theoretical path, and then modify it using the Rechain Line tool described 
above. To add a new line along the theoretical path, you will need to use the snap-to-grid 
functionality described below. 

Snap to grid 

See “Grids” on page 24 for more information. 

Deleting hangers 

Suppose you have just trimmed a project to some geographic boundary, and this has left 
you with a lot of stations which don’t form complete “boxes” in the project, as shown in 
Figure 87. 

 

Figure 87 - A survey with "hangers" 

It is possible to clean this up by selecting the individual salvos and deleting them. On a 
large survey, this could take a very long time. For that reason, we have developed the 
Delete Hangers tool. To access this tool, right-click on a project layer in the layer view 
and choose Delete Hangers from the context menu. The Delete Hangers tool is shown in 
Figure 88. 
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Figure 88 - The Delete Hangers tool 

To use the tool, click Select. The tool will highlight all the hangers in the tool colour (by 
default, green), as shown in Figure 89. 

 

Figure 89 - The Delete Hangers preview 

The highlighted segments, called “hangers”, are really just sections of line which are not 
bounded on both sides by an intersection with another line. In some cases, particularly 
when you have imported the survey from an external source, the tool may identify several 
incorrect hangers because a line doesn’t quite make it to the intersection. Individual 
sections of line can be toggled as marked/unmarked by clicking on them. 

When you have checked that all the hangers are correctly identified, click Apply. The tool 
will delete the marked sections, as shown in Figure 90. 
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Figure 90 - The same survey without "hangers" 

Rotating and moving a project 

To rotate or move a project, use the Rotate/Move Project tool. To use this tool, right-click 
on a project in the layer view and choose Move Project from the context menu. The tool 
is shown in Figure 91. 

 

Figure 91 - The Rotate/Move Project tool 

This tool can be used to rotate or move all or part of a project. Only visible portions of 
the project will be moved, so it’s possible to move, for example, just the receivers by un-
checking the sources in the Layer View. 

Changes can be made manually or by dragging in the map view. To rotate or move the 
project manually, first select a project from the drop-down list at the top of the tool. Next, 
enter the rotation angle and direction, fixed point location, and translation distance. 
Check your values and click Apply. To apply a rotation only, set the translation distance 
to zero. To apply a translation only, set the rotation angle to zero. 
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To move the project in the map view, click and drag the project in the map. A “ghost” of 
the project will follow, as shown in Figure 92. When you release the left button, the 
entire project will move into place. For very large projects, this may take a moment. 

 

Figure 92 - Dragging a project in the map view 

To rotate a project in the map view, first click to define the fixed point. This is the center 
of the rotation, and is marked with a green dot in the map. Next, hold Shift and click and 
drag in the map. Once again, a “ghost” of the project will follow. The further away from 
the fixed point you click, the better, since you are defining an “arm” which will control 
the rotation. If you click too close to the fixed point, the rotation may appear to be 
inaccurate. 

These two actions can be used, for example, to change a project’s northeast corner and 
line it up with existing trail very quickly. First, click and drag the northeast corner where 
you would like it to go. This has the side-effect of setting the fixed point. Next, move to 
the other end of the line. While holding Shift, click and drag the other end of the line so 
that it also lies along the existing trail. The project is now in place. 

Merging projects 

You will sometimes need to take two projects and make them one. One possibility is that 
you’ve generated theoretical positions for all your stations, and are now receiving 
surveyed positions. To handle this, load the theoretical stations into one project and the 
surveyed stations into another, as shown in Figure 93. 

 

Figure 93 - Two projects loaded 

Now drag the “surveyed” project onto the “theoretical” project. The “theoretical” project 
should be highlighted just before you release the left mouse button. 

When you release the button, you will be asked to confirm the merge operation. Click OK 
to continue. If the two projects have different coordinate systems, copied lines and 
stations will be converted to the target’s coordinate system. The merge process will splice 
sections of line (along with their stations) from the source project into the target project. 
Where possible, the boundaries of the splice will be joined. 
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Renumbering lines 

To renumber all the receiver or source lines, expand the project layer in the layer view 
and right-click on “Receivers” or “Sources”. From the menu, choose Renumber Lines. It 
is also possible to renumber just a few lines by selecting them in the layer view and right-
clicking on the selection. From the menu, choose Renumber Lines. This will bring up the 
dialog box shown in Figure 94. 

 

Figure 94 - Renumbering lines 

Our goal with the Renumber Lines tool was to design a tool which makes simple 
renumbering tasks easy, and hard ones possible. For simple renumbering tasks, you will 
usually renumber all the receiver lines or all the source lines. The tool will automatically 
detect the lowest and highest lines in the selection, as well as the line number increment. 

By default, the tool will look for missing lines, and adjust the line numbers accordingly. 
To disable this feature, and renumber lines in sequence regardless of the space between 
them, uncheck the Look for gaps checkbox. 

Also by default, the tool will retain the current order of the lines. If your line numbers 
increase from north to south before the operation, they will do so afterward as well. To 
reverse the order of the lines, check the Reverse order checkbox. 

Finally, you can choose to renumber the lines starting with the highest number, or with 
the lowest. If your line numbers increase from north to south, for example, then 
renumbering from the lowest line number will fix the number at the north end of the 
survey, and increment going south. There is no need to make the increment negative if 
you are renumbering from the highest line number—DirectAid will automatically 
decrement instead of incrementing. Once you have set everything up, click Apply to 
renumber the selected lines. 
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In the extreme, the Renumber Lines tool can be used to renumber individual lines. Just 
right-click on the line in the layer view and choose Renumber Lines from the menu. In 
this case, it doesn’t matter if you renumber from lowest or highest, look for gaps, or 
reverse order. To renumber a single line, just enter the new line number in the From 
lowest edit box, and click Apply. 



If you have specified a renumbering scheme which results in two lines having the same 
line number, DirectAid will warn you that the operation cannot be completed. Lines must 
have unique line numbers. 

Renumbering stations 

The Renumber Stations tool can be used to renumber all the sources or receivers, just the 
stations in a single line, or any group of stations that you can select. To renumber all the 
sources or receivers, expand the project layer in the layer view and right-click on 
“Receivers” or “Sources”. From the menu, choose Renumber Stations. To renumber just 
the stations in a single line, right-click on the line and choose Renumber Stations. To 
renumber a selection of stations, first use the Select Objects and Select Area tools to make 
your selection. Right-click on the selection and choose Renumber Stations from the 
context menu. Any of these methods will bring up the dialog box shown in Figure 95. 

 

Figure 95 - Renumbering stations 

The Renumber Stations tool options are very similar to the options for Renumber Lines, 
described above. The tool automatically detects the lowest and highest station numbers in 
the selection. If you renumber from the lowest station number, for example, then the first 
selected station on each line will be given that number. 

Often, you want to renumber the stations on each line so that they “line up” along some 
axis. For this reason, we have introduced the renumber from reference option. If you 
select this option, a green line will appear in the middle of the survey. You can click and 
drag anywhere in the map view to move the line. When you renumber using this method, 
DirectAid will begin numbering where the reference line intersects the project line, as 
shown in Figure 96. 
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Figure 96 - Renumbering stations using a reference line 

There are some subtleties to using the reference line. DirectAid renumbers first in the 
forward direction, starting at the reference line. If you have enabled the look for gaps 
option, then it will look for a station within half a station interval of the reference line. If 
it does not find a station, it will “skip” station numbers as needed. When it is done 
renumbering in the forward direction, DirectAid renumbers in the reverse direction, 
beginning with the first station it found in the forward direction. In Figure 96, we have 
renumbered from the reference line with a station number of 150. As you can see, for the 
line on the left this has actually placed 150 just below the line, since the station in the 
forward (upward) direction is more than half a station interval from the reference line. 

Stations are normally renumbered with station number increasing from the beginning of 
the line to the end of the line. It is possible to reverse the numbering for complete lines by 
checking the Reverse order checkbox. The checkbox will only be enabled if you have 
selected complete lines. This is because station numbers must always increase going from 
the beginning to the end of the line, so it is not possible to reverse the numbering for a 
portion of the line. 

Once you have set everything up, click Apply to renumber the selected stations. If you 
have specified a renumbering scheme which results in two or more stations having the 
same station number, DirectAid will warn you that the operation cannot be completed. 
Stations must have unique station numbers. 

The measuring tool 

The measuring tool can be used to measure areas and lengths in the map view. To use the 
measuring tool, either select Measure from the Tools menu, or click the button in the 
toolbar ( ). This will bring up the dialog box pictured in Figure 97. 
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Figure 97 - The measuring tool 

To use the measuring tool, first choose either Show area or Show length. Then click in 
the map to define vertices. If you are measuring an area, the tool will draw the area as 
you define it, as shown in Figure 98. 

 

Figure 98 - Measuring an area 

If you are measuring a length, the tool will draw the edges as they are defined, as shown 
in Figure 99. To change measurement units, choose from the list at the bottom of the 
dialog box. To clear the vertices, click the Clear button. 
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Figure 99 - Measuring a length 

Breaking and joining lines 

The Break/Join Lines tool can be used to break one line into two, or join two lines to 
make a single line. To use the tool, right-click on a project in the layer view and choose 
Break/Join Lines from the context menu. 

To break a line between two stations, click between the stations in the map view, as 
shown in Figure 100. 

 

Figure 100 - Breaking a line 

When you click on the line, DirectAid will ask you to provide a new line label for the 
shorter of the two newly created line halves. The line label must be unique. Click OK to 
finish breaking the line. 

 

Figure 101 - Choosing a new line label 

A newly broken line is shown in Figure 102. Note that the line break is automatically 
moved to the nearest salvo edge, if possible. 
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Figure 102 - The result of breaking a line 

Before joining two lines, you must make sure that the station numbering of the two lines 
does not overlap, and that the joined line will be numbered sensibly. For example, if you 
want to join a small stub line onto the end of a longer line, then the stub line’s numbering 
must begin after the last station of the longer line. To renumber the stations in one of the 
lines, use the Renumber Stations tool described on page 63. 

To join two lines, click and drag from the EOL of one to the BOL of the other, or vice 
versa. Allowable targets are drawn with a small symbol, as shown in Figure 103. The 
cursor will snap to them. 

 

Figure 103 - Line end targets 

When you click on one line end, only the line ends it can be connected to will remain 
highlighted, as shown in Figure 104. 

 

 

Figure 104 - Line end targets after picking first end 

Dragging to one of the allowable targets will draw a temporary line between the two 
ends, as shown in Figure 105. 

 

Figure 105 - Ready to connect two lines 
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Finally, letting go of the mouse button will complete the operation, and cause the two 
lines to be joined, as shown in Figure 106. The new line will share the same name as the 
longer of the two original lines. 

 

Figure 106 - Two lines connected 

Locking a project 

The geometry of a locked project—the position of its lines and stations—cannot be 
changed. To lock or unlock a project, right-click on the project in the layer view and 
choose Lock from the context menu. When a project is locked, the Lock menu item will 
be checked, and a small “lock” symbol will also appear in the layer view, as shown in 
Figure 107. 

 

Figure 107 - A locked layer 

Observer’s Logs 

Importing observer’s logs 

The observer’s log import can read either ARAM text files, or the full Sercel observer’s 
log. 

To import an observer’s log, right-click on a project in the layer view and choose Import 
and then Observer’s logs from the context menu. In the Open dialog, pick a type using 
the Files of type dropdown at the bottom. By default, the dialog looks for files ending in 
“.txt”. If you want to find a file which doesn’t end in “.txt”, just enter “*.*” in the File 
name, hit enter, and the file list should be updated to include everything. Choose the file 
to import and click Open. For each source station listed in the log, DirectAid will update 
the “_Date_Shot” property to the date indicated in the log. 

Marking shots 

Now that the properties have been imported, you probably want to do something with 
them. The first thing to do is probably to see what’s been shot. To do this, go to Manage 
Fields in the Tools menu. Select the “_Date_Shot” property, and click Options. Click 
Visualization. From the drop-down, choose Points. This will mark every station with the 
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“_Date_Shot” property as indicated by the rules below. The simplest thing is just to mark 
all the stations which have been shot. To do that, use settings such as those shown in 
Figure 108. 

 

Figure 108 - Marking shot sources 

This will mark each station which has been shot with a 3 mm radius orange circle. If we 
just want to mark the ones which were shot on a particular date, we can do this as shown 
in Figure 109. 

 

Figure 109 - Marking sources shot on a particular date 

This will mark every station shot on January 28, 2008 with a 3 mm radius orange circle. 
Finally, we can chain several of these rules together by clicking the “+” sign to the right 
of the colour. This will add a second line, which will be used if the first one fails. For 
example, we might use the chain of filters shown in Figure 110. 
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Figure 110 - Marking sources shot on a range of dates 

This would mark stations with different colours depending on the date they were shot. If 
we wanted to handle wider ranges of dates, we adjust the filters as shown in Figure 111. 

 

Figure 111 - Marking sources shot on a wide range of dates 

Because the filters act in the order they’re entered, this will colour stations according to 
the week they were shot. 

What has not been shot? 

Finally, you can quickly generate a report indicating which sources have not been shot. 
Change to the “Reports” tab and open the “Miscellaneous reports” folder. Right-click on 
“Unshot sources” and choose Run from the context menu. The first time you do this, it 
may take a moment to compile the Python scripts. You will be presented with report 
options which affect the appearance of the report. Click OK to continue, and the report 
should open in Adobe Reader. Ranges of unshot sources are itemised by line. If an entire 
line is unshot, the right column will say “all”. If every station is shot, the column will 
read “none”. 
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Drawings 

Reading/writing drawings 

Reading 

To import vector data, choose Vector layer in the Import pop-up menu. You will first be 
asked to select the files to import. For vector layers, files imported in a single operation 
are loaded into separate layers, and may have different coordinate systems. When you 
have selected one or more files, click Open to continue. 

Next, the vector import wizard will appear. This wizard contains the three coordinate 
system pages. When you have entered any required information in the import wizard, 
click Finish to import the first vector file. When the import is complete, the process will 
be repeated for any other vector data you may have selected for import. As usual, you 
may need to un-zoom ( ) in order to see the drawings. 

Writing 

DirectAid can export a drawing layer as a DXF or ESRI Shapefile in any coordinate 
system. Thus, it can be used to convert between DXF and Shapefile formats, and between 
coordinate systems as well. To export a drawing layer, right-click on the layer in the layer 
view and choose Export from the context menu. After giving the file a name, you will see 
the three standard coordinate system pages. 

Lastly, you will be asked to specify a “precision” for the exported file. Because a straight 
line in one coordinate system may be a curve in another, it is sometimes necessary to 
represent a single edge as several edges when converting a drawing. The precision 
parameter determines when this kind of edge division should end. Lines in the exported 
file will not err by more than the specified distance. Verify the export coordinate system 
and precision, then click Finish to complete the operation. 

DirectAid can also export a project layer as a DXF or ESRI shapefile. To export a project 
layer as a drawing, right-click either the project layer or the “Source” or “Receiver” layer 
in the project, and choose Export from the context menu. In the drop-down list labeled 
“Save as type” at the bottom of the Save As dialog, you should see both DXF and 
Shapefile as options. Choose one of these two file types and click Save. Choose a 
coordinate system and precision as above, then click Finish to complete the operation. 

Editing drawing layers 

Most of the properties of a vector object are accessible either through the Properties 
dialog box, or through map object selection mode in the map view. A vector layer can 
contain five basic objects: groups, points, polylines, polygons and text. 
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Groups 

A group collects several vector objects into a single parent object. A group may contain 
any of the five basic objects, including sub-groups. When a group is in a grouped state, 
actions on the group, for example selection and dragging operations, will act on every 
member of the group. If a group is temporarily ungrouped, it acts as a transparent folder 
for its members, which can be selected and edited independently. 

To ungroup a group temporarily, first select the group. A selected group is drawn with a 
bounding box surrounding the selected group members, as shown in Figure 112. 

 

Figure 112 - A selected group 

With the group selected, double-click on any selected group member to ungroup it 
temporarily. Every member of the group will remain selected, but the bounding box will 
not be drawn. A temporarily ungrouped group is shown in Figure 113. 

A temporarily ungrouped group will return to its grouped state when none of its children 
are selected. Otherwise, it will remain ungrouped. This means that we can, for example, 
edit the nodes of a child polygon by double-clicking on the ungrouped child. 
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Figure 113 - An ungrouped group 

Points 

A point is the simplest vector object. It is a position marked with some symbol. In 
DirectAid, a station is implemented as a special case of a point. 

The Properties dialog for a point, or for any layer containing a point, has a Point Style 
page, shown in Figure 114. Note that the symbol size is specified in page millimetres. 

 

Figure 114 – The point style page 
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In addition to its properties, there is a single operation which can be performed on any 
point in the map view. To move a point, just select the point and drag it as you would a 
station. 

Polylines and polygons 

A polyline is a series of points connected by edges. Each edge may be connected, in 
which case it is normally displayed, or it may be broken, in which case it is displayed 
only as a thin line in node editing. A polygon is simply a polyline whose first and last 
points are defined to be the same. In DirectAid, a project line is implemented as a special 
case of a polyline. 

The Properties dialog for a polyline, or any layer containing a polyline, has a Line Style 
page, shown in Figure 115. Once again, note that line weight is specified in page 
millimeters. 

 

Figure 115 - The line style page 

To edit a polyline, select the polyline then double-click the selection. The details of 
polyline editing are given in the section ”Editing lines” on page 51. 
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Text 

A text box in DirectAid is defined in source coordinates. That is, the box and the text 
inside it lie at a particular position on the ground, regardless of the camera coordinate 
system. The Properties dialog for a text box, or any layer containing a text box, has a 
Text Style page, which is divided into five stacked sub-pages: alignment, font, layout, 
text, and text box. To switch between the sub-pages, use the drop-down box located in 
the top-right corner of the Text Style page. At the bottom of the page is a preview of the 
text within the box. 

The text box is positioned in source coordinates relative to an alignment point. The 
Alignment sub-page, shown in Figure 116, specifies how the text box will be positioned 
relative to the alignment point. Horizontally, the alignment point may lie at the left edge 
of the box, in the center, or at the right edge of the box. Vertically, the alignment point 
may lie at the bottom edge of the box, in the middle or at the top edge of the box. If the 
text box contains a single line of text, the alignment point may lie along the baseline of 
the text. 

 

Figure 116 - Text alignment properties 

The Font sub-page, shown in Figure 117, specifies the font name, size, style and colour 
which will be used for text within the box. Note that the font size is measured in source 
units and specifies a size on the ground. 

 

Figure 117 - Text font properties 

The Layout sub-page, shown in Figure 118, specifies how the text will be arranged within 
the text box. Line spacing is the distance between the baselines of consecutive lines of 
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text, measured in multiples of the height of a single line of text. In addition, the Layout 
sub-page contains options to mirror the text horizontally or vertically, and to enable to 
disable word wrap. 

 

Figure 118 - Text layout properties 

The Text sub-page contains the actual text which will be drawn in the text box. Use this 
page to modify the text. 

Finally, the Text Box sub-page, shown in Figure 119, specifies the text box dimensions 
and background colour. To the left of each dimension is a check box labeled Auto. When 
the box is checked, that dimension will be automatically calculated based on the 
dimension of the enclosed text and margins. When the box is unchecked, the dimension is 
fixed to a user-specified value. Note that these dimensions are measured in source units 
and specify a size on the ground. 

 

Figure 119 - Text box properties 

In addition to these properties, a text box can be edited in the map view. To edit a text 
box, change to map object selection mode and select a text box. The text box will appear 
with a transparent overlay, as shown in Figure 120. 
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Figure 120 - Text box selection 

From this mode, a text box can be dragged. To edit the box orientation and size, double-
click the selected text box. When you are in editing mode, the text box will appear with a 
transparent overlay, as shown in Figure 121. 

 

Figure 121 - Text box editing 

To move the whole text box, drag the node located at the centre of the box. To change the 
dimensions of the box, drag the nodes located along the boundary. Note that if your text 
box is centre-aligned either horizontally or vertically, the box will grow symmetrically 
about that axis. To change the orientation of the text box, drag the point halfway between 
the centre and the right edge. 

Adding to a drawing 

To add to a drawing layer, right-click on it in the layer view and choose Draw from the 
context menu. This will bring up the Vector Draw Tool, which can be used to draw new 
objects in an existing vector layer. 

To create a new vector layer, right-click on the white space in the layer view and choose 
New then Vector Layer. 

Points 

To add points to a vector layer, choose the leftmost button in the Vector Draw Tool. The 
tool is shown in point mode in Figure 122. In the bottom of the tool, choose the colour, 
size, and symbol for the points, then click in the map view to define new points. 
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Figure 122 - Drawing points 

To edit or delete existing points, you will need to exit the Vector Draw Tool and follow 
the instructions above for point editing. 

Polylines 

To add polylines to a vector layer, choose the second button in the Vector Draw Tool. 
The tool is shown in polyline mode in Figure 123. In the bottom of the tool, choose the 
colour, weight, and pattern for the line, then click in the map view to define new vertices. 
Double-click on the last point to finish a polyline. 

 

Figure 123 - Drawing polylines 

Circles 

To add circles to a vector layer, choose the third button in the Vector Draw Tool. The tool 
is shown in circle mode in Figure 124. In the bottom of the tool, choose the colour, line 
weight, line pattern, and optionally the radius for the circle. To draw a circle with a 
predefined radius, set the radius in the tool and then click in the map to define the center 
of the circle. A circle can also be drawn by clicking and dragging in the map, to define 
first the center of the circle and then the radius. Subsequently clicking in the map will 
draw more circles with the same radius. 
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Figure 124 - Drawing circles 

Text 

To add a text label to a vector layer, choose the rightmost button in the Vector Draw 
Tool. The tool is shown in text mode in Figure 125. In the bottom of the tool, choose the 
colour, font, style, size, angle, and contents for the text box. To draw a text label with a 
predefined height and orientation, specify the size and angle in the tool and then click in 
the map to define the left edge of the text box. Alternatively, you can click and drag in 
the map to define first the left edge, and then the size and orientation of the text box. 
Subsequently clicking in the map will draw more labels with the same size and 
orientation. 

 
Figure 125 - Drawing text 
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Images 

Reading images 

To import an image, choose Image layer in the Import pop-up menu. You will first be 
asked to select the files to import. For image layers, files imported in a single operation 
are loaded into separate layers, and may have different coordinate systems. When you 
have selected one or more files, click Open to continue. 

What happens next depends on the auxiliary information available for the image. This 
information may be in the form of an OziExplorer MAP file or a TFW file. If you are 
importing a TIFF file, this information may also come from GeoTIFF tags. Information 
will be read automatically from any auxiliary file which has the same filename but a 
different extension. DirectAid 2.0 first looks for a MAP file, then a TFW file, and finally 
it looks for GeoTIFF tags if they are available. If it cannot find any of these data sources, 
or if the information in the files is incomplete, DirectAid will ask which auxiliary file you 
would like to use. This dialog is shown in Figure 126. 

 

Figure 126 - Auxiliary files 

To use the information from a particular file, choose that file and click OK. To browse for 
an auxiliary file which may be in another location, or may not have a filename similar to 
the image file, click Browse. If you wish to enter georeferencing information for the 
image manually, choose “no auxiliary file” and click OK. For more information on 
rectifying an image manually, see “Image rectification” below. 
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Figure 127 - Image georeferencing 

If the auxiliary information for the image was incomplete, the image import wizard will 
appear. Only information which has not been specified in auxiliary files will be requested 
at this point. The image import wizard may include the three coordinate system pages. It 
may also include a georeferencing page, as shown in Figure 127. This page allows the 
user to edit the matrix used to transform pixel coordinates to source coordinates. By 
choosing other options from the drop-down box in the bottom right of the page, it is also 
possible to reference the image by choosing pairs of pixel and source coordinates. 
However, at this time only matrix referencing can be used on import. 

When you have entered any required information in the import wizard, click Finish to 
import the first image file. When the import is complete, the process will be repeated for 
any other images you may have selected for import. As usual, you may need to un-zoom 
( ) in order to see the images. If you still cannot see the images, you may have chosen a 
datum or projection which is not valid for the project area. Another possibility is that you 
are looking at the back side of the image, which is not visible. If your camera projection 
is set to ECEF, you may need to rotate the globe to make your image visible. Otherwise, 
you should be able to correct the problem by re-squaring your camera axes ( ) and un-
zooming again. 

Image rectification 

Using DirectAid, you can rectify images which come without georeferencing 
information. You will still need to know what coordinate system the image belongs in, 
but we have made it easy to position images relative to other layers. 

To read an unreferenced image, import the image as usual. When you are asked to 
identify an auxiliary file, select “no auxiliary file”, as shown below, then click “OK”. 
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Define the units, datum, and projection for the image coordinate system using the image 
import wizard. The last page of the wizard asks you to define georeferencing information. 
The page should default to a “matrix reference” with all the values set to zero. Click 
“Finish” to complete the import without georeferencing information. 

Once the image is read, it will show up in the layer view, but not in the map view. Right-
click on the image and choose “Move Image” from the menu. This will bring up the 
Move Image tool in its initial state, shown below. 

 

As the tool indicates, you can click and drag in the map view to define a rectangle for the 
image. The point you click on will be the top-left corner of the image, and the point you 
drag to will be the bottom-right, as shown below. The transform is updated in real time so 
you can see the effect of your movement. 

 

With the initial placement complete, the Move Image tool changes, as shown below. 
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The image can be moved, rotated, and resized using simple mouse actions. Rotation 
occurs about the fixed point, which can be changed by clicking on the image. The fixed 
point is indicated in the map view by a circle and crosshairs. Any single action in the 
Move Image tool can be undone/redone as usual. 

Once the image is roughly in place, you may want to refine the transform using control 
points. To enter control points, click “Use control points” in the Move Image tool. The 
tool will change as shown below. 

 

To define control points, click on an image feature and drag it to the place where you 
want it to be in the map view. Control points are indicated by a circle and crosshairs, as 
shown below. 
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If you have defined three or fewer control points, then DirectAid will be able to match all 
control points exactly using a linear transform. If you define four or more control points, 
DirectAid may not be able to put the image feature exactly where you indicate, In this 
case the circle and crosshairs may not line up exactly, as shown below. 

 

The circle indicates the position of the map feature, and the crosshairs indicates where 
you are trying to put it. The distance between the two is the transform error. If you have a 
significant distance between the two, there are a few possible causes: 

• You may have picked the wrong image feature or position. In this case, you will 
need to delete and redefine the control point as described below. 

• You may have picked the wrong coordinate system for the image. The linear 
transform used by DirectAid cannot, for example, squeeze an image at the top and 
stretch it at the bottom (an effect commonly known as keystoning). If it appears 
that you need this kind of transform, you may need to switch the image coordinate 
system from “UTM” to “latitude/longitude”, for example. 

As mentioned above, it is possible to delete control points which have been entered. If 
you have just finished entering an incorrect control point, it is probably fastest to undo 
the operation. Otherwise, place the mouse over a control point. It should appear 
highlighted, as shown below. Right-click on the control point and choose “Delete” from 
the menu. The transform should be updated immediately. 

 

If you have defined control points, and then subsequently uncheck the “Use control 
points” box and re-transform the image, you will lose your defined control points. This is 
because control points generally tie an image feature to a position in the real world. When 
the image is re-transformed by hand, there is no reliable way to adjust the control points. 
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Image properties 

To change image properties, right-click on the image in the layer view and choose 
Properties from the context menu. The Properties dialog contains the usual three tabs for 
coordinate system information, as well as a Georeferencing tab and a Clipping tab. 

Image georeferencing 

The Georeferencing tab in the image properties dialog specifies the conversion from 
image coordinates (measured in image pixels) to the “source” coordinate system 
(specified by the three standard coordinate system tabs). When an image is imported, this 
information is usually obtained either from GeoTIFF tags, a TFW file, or an OziExplorer 
MAP file. An image may be georeferenced using control points in either geodetic 
coordinates (lat/long) or grid coordinates (e.g. UTM or State Plane coordinates), or using 
a specific linear transform. In the latter two cases, the control points are converted to a 
linear transform. To select a method, choose from the drop-down list in the bottom-right 
corner of the page. 

Image clipping 

At this time, the only part of an image layer which can be edited outside its Properties 
dialog box is the clipping boundary. To edit the image clipping boundary, change to map 
object selection mode and double-click the image. The clipping boundary will be drawn 
with a transparent overlay and a thick box at each node of the boundary. To edit the 
boundary, you can either click and drag the nodes, or create a new node by clicking on an 
edge. To remove a node, right-click on the node and select Delete from the context menu. 

An image clipping boundary is defined not only by the nodes, but also by the curve that 
the edges follow between the nodes. In particular, it is common for the edges to follow 
one of two curves. The curve may follow a line which is straight in grid coordinates, or it 
may follow a line which is straight in geodetic latitude/longitude. The curve may also 
follow a line which is straight in pixel coordinates, but this is usually just a special case 
of one of the previous two options. To change the clipping mode, go to the image 
properties by right-clicking on the image either in the layer view or in the map view, and 
choosing Properties from the context menu. Remember that the context menu can be 
accessed from the map view only if you are in map object selection mode. Choose the 
Clipping tab. You should see something like Figure 128. 



 

Figure 128 - Image clipping 

The drop-down box in the bottom-right indicates which clipping mode is currently active. 
To change the clipping mode, select a new mode from the drop-down. Note that the 
vertices of the clipping polygon are specific to a particular clipping mode, so the vertex 
list for some modes may be blank. At this time it is not possible to add or remove vertices 
from this interface, although it is possible to edit the vertex positions. When you have 
finished, click OK to close the dialog box. 

Image Transparency 

To change an image’s transparency level, open its Properties and change to the General 
tab. Adjust the slider labeled “Opacity”. This can be especially useful when you’re 
georeferencing an image against a background image. 

Printing and Print Preview 

To print the current workspace to a printer using the same centre and scale as in the map 
view, choose Print from the File menu, or use the toolbar button ( ).. This will bring up 
the standard Windows print dialog, where you can choose a printer, set printer properties, 
and set the number of copies. To complete the operation, click OK. 

As usual, page and printer options can be changed using the Page Setup command, 
located in the File menu. To preview the print, choose Print Preview from the File menu. 
By clicking with the left mouse button in the preview area, the user can cycle through 
three standard zoom settings. 
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Printing to a File 

Printing a whole page 

There are two methods of printing to a file in DirectAid. The first is analogous to printing 
to the printer. This method will result in a file which has the same centre as the current 
map view, but with a user-defined scale, page size and resolution. To print using this 
method, choose Print To File from the File menu. You will be prompted for a file name 
and type. DirectAid 2.0 will add the appropriate extension to the file name if you do not 
enter one yourself. When you have done, click Save to continue. This will bring up the 
first page of the print -to-file wizard, as shown in Figure 129. 

 

Figure 129 - Printing a whole page (step 1) 

On the first page of the wizard, you are asked to choose the page dimensions. You may 
choose from three standard paper sizes, or you may specify a custom paper size. If you 
choose the former, you may also choose to print in portrait or landscape orientation. 
Finally, you may adjust the page margins. The output file will include only the page area 
within these margins. When you are satisfied with your choices, press Next. This will 
bring up the second page of the wizard, as shown in Figure 130. 

On the second page of the wizard, you are asked to choose the map scale and image 
dimensions. If your camera coordinate system is geodetic latitude/longitude, this scale 
will be measured in degrees per page metre. Otherwise, the scale will be measured in 
units on the ground per unit on the page, as in standard maps. 
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There are three choices for determining image dimensions. First, you may specify a 
world scale, measured in metres on the ground per image pixel. This is typical for images 
which will be read back into mapping software, where the resolution you have in mind is 
measured on the ground. Second, you may specify a page scale, either in dots per page 
inch, or page millimeters per pixel. This is useful if you intend to send the image to a 
printer, and have a target resolution in mind. Finally, you may choose to specify the size 
of the image directly. You might use this option if you are planning to send the image by 
e-mail and have a particular image size in mind. In either of the three cases, the inactive 
options will be updated as you edit the active option, so that you can perform a “reality 
check” on the numbers. 

 

Figure 130 - Printing a whole page (step 2) 

In some cases, this is all there is to the wizard. In other cases (for example when writing a 
JPEG file), there may be further pages where you may specify parameters specific to the 
image format. When you are done, click Finish to generate the image. 

In addition to the image file itself, DirectAid will generate an auxiliary OziExplorer MAP 
file and TFW file. If you are writing a TIFF image, DirectAid will also write GeoTIFF 
tags to the output file. The output image will be referenced in the camera coordinate 
system. 

Printing a region 

The second printing method is used if you want to print a particular part of the map view 
to an image file. First, select the page-area selection tool, either by choosing Page area 
from the Selection menu, or using the toolbar button ( ). Now select an area of the map 
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view by clicking and dragging across the map. The selected area will be bounded by an 
animated box. To clear this selection when you are done, simply click anywhere in the 
map without dragging. The page-area selection does not clear when you switch back to a 
different tool (for example, the pan or zoom tools). 

Once you have selected your desired image area, once again choose Print to File from the 
File menu. You will be prompted for a file name and type. DirectAid 2.0 will add the 
appropriate extension to the file name if you do not enter one yourself. When you have 
done, click Save to continue. This will bring up a different print-to-file wizard, as shown 
in Figure 131. 

 

Figure 131 - Printing a region 

On this page you are essentially being asked to specify the page dimensions. Whereas 
with the first method the area covered by the image could vary depending on page size 
and scale, in this case we have fixed the coverage area by selecting it within the map 
view. We can either specify the map scale, in which case the page size will be updated 
automatically, or we can specify the page size in millimetres, in which case the map scale 
is calculated. When you are done, click Next to continue. 

The second page of this wizard is very similar to the second page of the wizard shown in 
Figure 130, except that map scale has been moved to the first page because of its effect 
on page size. Other than this small change, the second page of the wizard is still used to 
determine image dimensions. In some cases, again, there may be additional pages in the 
wizard, requesting parameters specific to the image format. When you are done, click 
Finish to generate the image. As before, auxiliary georeferencing information will also be 
written. 
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This method of printing to a file can be used to generate image mosaics using source 
images in any coordinate system. First, set the camera coordinate system to your desired 
output datum and projection. It may be necessary to re-square your camera axes ( ) so 
that the output image is square to the desired coordinate system. Second, import whatever 
images you would like to include in the mosaic. Finally, select the area to be output in the 
mosaic and use Print to File to write the image. When generating image mosaics, the 
“map scale” and “actual size” on the first wizard page will have no effect on the output. 
These parameters affect only the size of symbols and lines, whose thickness is referenced 
in page coordinates. 

Version Control 

With DirectAid 2.0, we have taken the concept of “undo/redo” a bit further than you may 
be used to. The program logs every change made to a workspace. There are two main 
methods of working with this log: undo/redo and reverting a layer. Collectively, we refer 
to these methods as version control. 

Undo/redo 

The simplest form of version control is the undo/redo functionality you are probably 
already familiar with. To undo actions in the reverse order in which they were done, 
either choose Undo from the Edit menu, or press Ctrl-Z. To redo an action which has just 
been undone, choose Redo from the Edit menu, or press Ctrl-Y. Although most actions 
can be undone, there are a few (for example, deleting an entire project) which cannot be 
undone because a large amount of data would need to be stored in order to ensure the 
action could be undone. If you perform such an action, DirectAid will display a warning 
dialog asking if you would like to save the data to disk before modifying it. 

Reverting a layer 

In addition to undoing changes in order, in some cases it is also possible to undo changes 
just to a part of the workspace (a single layer and all the layers it contains). There are two 
ways to do this. The first method, a partial undo, can be used to roll back a series of 
changes made to a particular layer (or its contents). The second method, a revert, is more 
like a “time machine”. It allows you to bring the layer (and its contents) back to some 
previous state. These states are usually identified by bookmarks. 

Partial undo 

The simplest way to revert a part of the project is to undo only changes done to that part 
of the project. For example, suppose you have made many changes to a project, but wish 
to undo only a few changes made to a particular line. First, right-click on the line in the 
layer view and choose Undo/Revert from the context menu. This will bring up the 
Undo/Revert Tool, shown in Figure 132. By default, the undo/revert tool shows a list of 
changes made to the layer (or any layer it contains). The most recent changes are shown 
at the top of the list. 
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Figure 132 - The undo tool Figure 133 - The undo tool (with selection) 

To undo changes, click on a single change. All changes above the selected change will 
also be selected, since it is impossible to undo one change without undoing everything 
that came after. With a selection made, click Undo to make the change. 

Bookmarks 

Before describing the process of reversion, it is important to describe how we will know 
“where” to go back to. Although each state resulting from a change to the workspace is 
marked with the date and time, this is clearly not the best way to look back. After all, do 
you really know if the state you want to go to was the created at 9:30 this morning, or at 
9:35? For this reason, we have created bookmarks. 

A bookmark is a description you can assign to a particular workspace state. For example, 
after you have created a new project, you might create a bookmark called “Created new 
project”. After you have trimmed the project, you might create another one called 
“Trimmed the project”. When you have moved a few lines to existing trail, you might 
create a third bookmark called “Move to existing trail”. If you later decide that you want 
to put a particular receiver line back the way it was just after you trimmed the project, 
you could revert that line to the bookmark called “Trimmed the project”. 

To create or modify a bookmark, either choose Bookmark from the edit menu, or use the 
shortcut key Ctrl-B. If the Edit Bookmark dialog does not appear, check that the main 
window is active, and not a tool window. Enter a description for the bookmark, then click 
OK or hit Enter. We’ve made this as easy as possible in order to encourage you to use 
bookmarks often. It is an excellent idea to get into the habit of creating a new bookmark 
after you have made a series of related changes to the project. 
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Reverting 

Reverting is similar to the partial undo above, except that instead of specifying a group of 
changes to be undone, you will select a bookmark to “revert” to. To revert a layer, right-
click on the layer in the layer view and choose Undo/Revert from the context menu. In 
the drop-list labeled Show, select Bookmarks. The list below changes to show all the 
bookmarks to which the selected layer can be reverted, as shown in Figure 134. 

 

Figure 134 - The revert tool 

 

Figure 135 - The revert tool (expanded) 

By default, the revert tool shows only those states which have been bookmarked. To 
show every state, check the box marked Show all. The state list will be expanded as 
shown in Figure 135. In general, it is not advisable to revert to an unmarked state, since it 
is difficult to tell exactly what changes will be made. The complete list is provided in 
case you should forget to bookmark a state, but are lucky enough that the time stamp tells 
you what you need to know. 

With a selection made, click Revert to complete the action. The selected layer (and its 
contents) will be rolled back to the bookmark you chose. The revert itself becomes the 
most recent action. If you need to undo the revert action, for example if you reverted to 
the wrong place, just press Ctrl-Z. 
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Appendix A DirectAid Extensions to Python 

This section will be of interest mainly to users who are familiar with the Python 
programming language, and would like to build their own reports. In addition to the 
Python standard library, the reports supplied with DirectAid make use of the following 
free libraries: 

• The ReportLab Toolkit (http://www.reportlab.org/rl_toolkit.html) is used 
as a framework for generating PDF documents. 

• The Python Imaging Library (http://www.pythonware.com/products/pil/) 
is used for image manipulation. 

• NumPy (http://numpy.scipy.org/) is used for numerical analysis. 
• Matplotlib (http://matplotlib.sourceforge.net/) is used for histogram plots. 

Any user who is looking to design their own reports should consider familiarizing 
themselves with these packages. 

To generate reports, DirectAid launches an embedded instance of the Python interpreter. 
On initialization, several DirectAid-related modules are automatically added to the 
Python namespace. These modules give Python a way of interacting with DirectAid 
workspaces. 

In addition to this “low-level” interface, we have built a framework for generating PDF 
reports, based on the free libraries listed above. We have used this framework to build 
several reports which are included with DirectAid. 

Following is a reference describing some of the more important DirectAid extensions for 
Python. 

The low-level interface 

The modules, classes and functions associated with the low-level Python interface are 
outlined in Figure 136 below. 

The directaid module contains a single class: Property. This class is very 
important, since it is the main interface between Python and the DirectAid workspace. 

All DirectAid layers are exposed as a Property item within Python. DirectAid 
provides interfaces to access two layers directly: The active project and midpoint layers. 
Children of these layers can be accessed using child Property items, which are 
accessed using a dictionary-like interface. Child Property items include some built-in 
properties, and also the user-defined properties for that layer. For example, the following 
code iterates through all of the source lines, displaying their line number: 

from directaid import project 
root = project.root() 

http://www.reportlab.org/rl_toolkit.html
http://www.pythonware.com/products/pil/
http://numpy.scipy.org/
http://matplotlib.sourceforge.net/


sources = root[‘_SOURCES’] 
for line in sources: 

print ‘Source line %s’ % line[‘_LABEL’] 

The remainder of the modules comprising the low-level Python interface to DirectAid are 
described below. 

 

Figure 136 - The low-level Python interface 
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directaid.interface.app 

getPrintTileSize () 

Returns the size, in pixels, of image tiles used for printing. 

getDetailPlotScale () 

Returns scale at which detail plots become visible. 

getPythonPath () 

Returns the path for DirectAid’s Python extensions. 

directaid.interface.camera 

getCoordSysKey() 

Returns the camera’s coordinate system key. 

getDatumKey() 

Returns the camera’s datum key. 

getGroupKey() 

Returns the camera’s coordinate system group key. 

getUnitKey() 

Returns the camera’s linear unit key. 

getScale() 

Returns the camera’s scale. 

setScale(scale) 

Parameters 

scale The camera’s new scale. 

Sets the camera scale. 

getPosition() 

Returns the camera’s angular unit key. 
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setPosition(x, y, z) 

Parameters 

x, y, z The camera’s new position. 

Sets the camera position. 

getMinorKey() 

Returns the camera’s minor linear unit key. 

getMajorKey() 

Returns the camera’s major linear unit key. 

directaid.interface.geo 

class GeoObject 

 getName() 

  Returns the name of the object. 

 getKey() 

  Returns the object’s key string. 

class GeoAngleUnit(GeoObject) 

class GeoCoordSys(GeoObject) 

class GeoCoordSysGroup(GeoObject) 

class GeoDatum(GeoObject) 

class GeoEllipsoid(GeoObject) 

class GeoUnit(GeoObject) 

 suffix() 

  Returns the unit’s suffix. 

factor() 

  Returns the conversion factor to metres. 
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AngleUnit(key) 

Parameters 

key The key string for the angular unit. 

Returns the angular unit object. 

CoordSys(key) 

Parameters 

key The key string for the coordinate system. 

Returns the linear coordinate system. 

CoordSysGroup(key) 

Parameters 

key The key string for the coordinate system group. 

Returns the linear coordinate system group. 

Datum(key) 

Parameters 

key The key string for the datum. 

Returns the linear datum. 

Ellipsoid(key) 

Parameters 

key The key string for the ellipsoid. 

Returns the linear ellipsoid. 

Unit(key) 

Parameters 

key The key string for the linear unit. 

Returns the linear unit object. 
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convert(csIn, posIn, csOut) 

Parameters 

csIn The input coordinate system. 

posIn The input position. 

csOut The output coordinate system. 

Returns the converted position. 

directaid.interface.map 

class Tile 

__init__(self, cxStrip, cyStrip, cxPage, cyPage, 
mmWidth, mmHeight) 

  Parameters 

cxStrip Width of the tile in pixels. 

cyStrip Height of the tile in pixels. 

cxPage Width of the map in pixels. 

cyPage Height of the map in pixels. 

mmWidth Width of the tile in millimeters on the 
printed page. 

mmHeight Height of the tile in millimeters on the 
printed page. 

getImage(self, x, y, wTile, hTile) 

  Parameters 

x Position of left edge of tile, in millimeters 
from the left edge of the printed page. 

y Position of top edge of tile, in millimeters 
from the bottom edge of the printed page. 

wTile Width of the tile in millimeters on the 
printed page. 
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hTile Height of the tile in millimeters on the 
printed page. 

Returns an image property object containing the rendered map 
tile. 

hitTestWorld(pos) 

Parameters 

pos Page position to test, in millimeters, measured from 
bottom-left corner of the page. 

Returns a tuple containing the 3-dimensional world position which lies 
under the test point and on the camera datum. 

getCoordSys() 

Returns the camera’s coordinate system key. 

directaid.interface.midpoint 

root() 

Returns the active midpoint layer. 

class MidpointLayer 

histogram(self, args) 

Parameters 

args A list of tuples, each consisting of plot type, lower 
limit, upper limit, and bin count. For example: 
[(‘fold’, 1, 20, 20)]. 

Returns a numeric array containing the histogram data.  

limits(self, key) 

Parameters 

key The plot type, e.g. ‘fold’. 

Returns a tuple containing the minimum and maximum value for 
the specified plot type. 
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directaid.interface.plottypes 

value 

null No value plot 
fold Fold 
offsetGap Largest offset gap 
offsetDispersion Offset dispersion 
offsetSqGap Offset-squared gap 
offsetSqDispersion Offset-squared dispersion 
azimuthGap Azimuth gap 
azmiuthDispersion Azimuth dispersion 

detail 

null No detail plot 
midpoint Midpoint distribution 
offset Offset distribution 
offsetSq Offset-squared distribution 
azimuth Azimuth distribution 
offsetAzimuth Offset-azimuth distribution 

directaid.interface.project 

root() 

Returns the active project. 

getMinorFactor() 

Returns the factor to convert from project units to the camera’s minor 
unit. 

getMinorSuffix() 

Returns the suffix for camera’s minor unit. 

getMajorFactor() 

Returns the factor to convert from project units to the camera’s major 
unit. 

getMajorSuffix() 

Returns the suffix for camera’s major unit. 



The PDF report framework 

In principle, the low-level Python interface described above can be used in combination 
with any Python library to produce output of almost unlimited variety. Because users will 
very often want to produce reports in PDF format, we have assembled a framework, built 
around the ReportLab Toolkit and other freely available Python libraries, for doing just 
that. The modules, classes and functions comprising the PDF report framework are 
outlined in Figure 137 below. 

directaid

dialog

OptionDialog
IntEntry

StringEntry
SaveAsEntry
RangeEntry

PagesizeEntry
SaveAsOption

SaveAsPdfOption
PageSizeOption

RangeOption
LineRangeOption

run

exception

ReportError
NoActiveProjectError

NoActiveMidpointError
NoActiveProjectWarning

NoActiveMidpointWarning

reports utils

getNextIncrement

elements

Element
Document

PageTemplate
Chapter
Page

Paragraph
Image
Label
Collar

Histogram
Histogram2D

Map
PageBreak

ParagraphAndImage
Spacer

labels

MidpointLabel
ProjectLabel
ScaleLabel
SurveyLabel

GeometryLabel

pages

CrosslineSummary
LineSummary

ParameterSummary
ProjectPage

MidpointPage

pdf

PdfBookmark
PdfDocument

PdfDocTemplate
SetPageTemplate

 
Figure 137 - The PDF report framework 
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directaid.dialog 

class OptionDialog 

__init__(self, options, title='Report Options') 

Parameters 

options Report options. 

title Dialog title. 

onCancel(self) 

Called when “Cancel” button is pressed. 

onOK(self) 

Called when “OK” button is pressed. 

destroy(self) 

Destroys the dialog box. 

run(self) 

Shows the dialog box. 

setPosition(self, width, height) 

Parameters 

width Width of the dialog box in pixels. 

height Height of the dialog box in pixels. 

Centers the dialog box on the screen. 

getOption(self, key) 

Parameters 

key The option key. 

Returns the option value. 

getOptions(self) 
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Returns a dictionary of all options. 

addOptions(self, options) 

Parameters 

options A dictionary of options to add. 

Adds the options to the dialog’s dictionary. 

class IntEntry(Tile.Frame) 

__init__(self, master, row, label, val) 

Parameters 

master The parent widget. 

row Row in parent widget. 

label Text label. 

val Initial value. 

getValue(self) 

Returns the wrapped value. 

validate(self) 

Validates the wrapped value. 

class StringEntry(Tile.Frame) 

__init__(self, master, row, label, val) 

Parameters 

master The parent widget. 

row Row in parent widget. 

label Text label. 

val Initial value. 

getValue(self) 



 A-12

Returns the wrapped value. 

validate(self) 

Validates the wrapped value. 

class SaveAsEntry(Tile.Frame) 

__init__(self, master, row, label, filename, 
extension) 

Parameters 

master The parent widget. 

row Row in parent widget. 

label Text label. 

filename Default filename. 

extension Default extension. 

onSaveAs(self) 

Called when “Save As” button is pressed. 

getValue(self) 

Returns the wrapped filename. 

validate(self) 

Validates the wrapped filename. 

class RangeEntry(Tile.Frame) 

__init__(self, master, row, label, vals) 

Parameters 

master The parent widget. 

row Row in parent widget. 

label Text label. 
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vals A tuple consisting of minimum value, 
maximum value, value step, and unit suffix. 

getValue(self) 

Returns a tuple consisting of minimum value, maximum value, 
and value step.. 

validate(self) 

Validates the wrapped range. 

class PagesizeEntry(Tile.Frame) 

__init__(self, master, row, label) 

Parameters 

master The parent widget. 

row Row in parent widget. 

label Text label. 

getValue(self) 

Returns the wrapped pagesize. 

validate(self) 

Validates the wrapped pagesize. 

class SaveAsOption 

__init__(self, filename, extension) 

Parameters 

filename Default filename. 

extension Default extension. 

addDlgEntry(self, dlg, label) 

Parameters 

dlg Parent dialog box. 
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label Text label. 

Adds the a “Save As” entry to the dialog. 

class SaveAsPdfOption(SaveAsOption) 

__init__(self, filename) 

Parameters 

filename Default filename. 

class PageSizeOption 

__init__(self, size) 

Parameters 

size Default pagesize. 

addDlgEntry(self, dlg, label) 

Parameters 

dlg Parent dialog box. 

label Text label. 

Adds the a pagesize entry to the dialog. 

class RangeOption 

__init__(self, minimum, maximum, step, unit=None) 

Parameters 

minimum Minimum value. 

maximum Maximum value. 

step Value step. 

unit Unit suffix. 

addDlgEntry(self, dlg, label) 

Parameters 
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dlg Parent dialog box. 

label Text label. 

Adds the a range entry to the dialog. 

class LineRangeOption(RangeOption) 

__init__(self, minimum, maximum, step) 

Parameters 

minimum Minimum line number. 

maximum Maximum line number. 

step Line number increment. 

class ProgressDialog 

__init__(self, title='Report') 

Parameters 

title Dialog title. 

destroy(self) 

Destroys the dialog box. 

setPosition(self) 

Centers the dialog box on the screen. 

run() 

Shows the dialog box. 

directaid.exception 

class ReportError(Exception) 

__init__(self, message) 

Parameters 

message Error message. 
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class NoActiveProjectError(ReportError) 

__int__(self) 

class NoActiveMidpointError(ReportError) 

__int__(self) 

NoActiveProjectWarning() 

NoActiveMidpointWarning() 

directaid.reports.elements 

class Element 

__init(self) 

options(options) 

Parameters 

options Report options. 

Adds options for this element to the options list. 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

class Document(Element) 

__init__(self, filename, pagesize) 

Parameters 

filename Name of the file the document will be saved 
to. 

pagesize A tuple containing width, height of the page. 

add(self, chapter) 

Parameters 

chapter A chapter to be added to the document. 

Adds a chapter to the document. 
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getPrintableSize(self, template) 

Parameters 

template Page template. 

Returns a tuple containing width, height of the printable area of 
the page for this page template (not including margins). 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

class PageTemplate 

__init__(self, pagesize, leftMargin=0, 
rightMargin=0, topMargin=0, bottomMargin=0) 

Parameters 

pagesize A tuple containing width, height of 
the page. 

leftMargin Left margin, in millimetres. 

rightMargin Right margin, in millimetres. 

topMargin Top margin, in millimetres. 

bottomMargin Bottom margin, in millimetres. 

width(self) 

Returns the width of the prindtable area (not including margins). 

height(self) 

Returns the height of the prindtable area (not including margins). 

class Chapter(Element) 

__init__(self, doc, template=None, 
parentTemplate=None, title=None) 

Parameters 

doc Parent document. 
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template Page template for this chapter. 

parentTemplate Page template for the parent chapter. 

title Chapter title. 

add(self, element) 

Parameters 

element Element to be added to the chapter. 

Adds an element to the chapter. 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

class Page(Element) 

__init__(self, pagesize, title=None) 

Parameters 

pagesize Size of the page. 

title Page title. 

add(self, element, pos, align=’bl’) 

Parameters 

element Element to be added to the page. 

pos A tuple containing the x, y position of a 
corner of the element. 

align Specifies which corner lies at pos. 
Available options are ‘tr’, ‘tl’, ‘br’, 
and ‘bl’, which correspond to the top-
right, top-left, bottom-right, and bottom-left 
corners, respectively. 

Adds and element to the page. 

getFlowables(self) 
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Returns a list of ReportLab flowable objects. 

class Paragraph(Element) 

__init__(self, text, fontsize, 
fontname=’Helvetica’, alignment=’centre’) 

Parameters 

text The text of the paragraph. 

fontsize Size of the font (point size). 

fontname Name of the font. 

alignment Text alignment. Available options are 
‘left’, ‘right’, and ‘centre’. 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

class Image(Element) 

__init__(self, data, width, height=None, 
iwidth=None, iheight=None, mode=’RGB’) 

Parameters 

data Either an image filename, or raw pixel data 
for the image. If this parameter is a 
filename, iwidth,  iheight, and mode 
are ignored. 

width Image width in millimeters. 

height Image height in millimeters. 

iwidth Image width in pixels. 

iheight Image height in pixels. 

mode Image mode, as documented in 
PIL.Image.frombuffer. 

getFlowables(self) 
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Returns a list of ReportLab flowable objects. 

class Label(Element) 

__init__(self, data, width, height, border=True, 
grid=False, style=None) 

Parameters 

data Write something here. 

width Label width in millimeters. 

height Label height in millimeters. 

border Draw a border around the label. 

grid Draw a grid between label entries. 

style A ReportLab TableStyle object 
specifying optional style parameters for the 
label. This is documented in 
reportlab.platypus.TableStyle. 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

class Collar(Element) 

__init__(self, width, height, size=0.5*inch, 
dpi=300) 

Parameters 

width Width of the box containing the collar in 
millimeters. 

height Height of the box containing the collar in 
millimeters. 

size Thickness of the collar in millimeters. 

dpi Resolution of the collar. 

clientArea(self) 
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Returns a tuple containing the width, height of the inner box of 
the collar.. 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

class Histogram(HistogramBase) 

__init__(self, width, height, mp, xaxis, heading, 
align=’edge’, factor=1, suffix=’’, dpi=300) 

Parameters 

width Width in millimeters. 

height Height in millimeters. 

mp A midpoint layer. 

xaxis Label for the horizontal axis. 

heading Histogram label. 

align Value alignment. To align at the left edge of 
the bar, use ‘edge’. To align in the centre 
of the bar, use ‘centre’. 

factor Factor to multiply histogram units by for 
display. 

suffix Unit suffix. 

dpi Resolution of the histogram. 

class Histogram2D(HistogramBase) 

__init__(self, width, height, mp, xaxis, yaxis, 
heading, align=’edge’, xfactor=1, yfactor=1, 
xsuffix=’’, ysuffix=’’, dpi=300) 

Parameters 

width Width in millimeters. 

height Height in millimeters. 
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mp A midpoint layer. 

xaxis Label for the horizontal axis. 

yaxis Label for the vertical axis. 

heading Histogram label. 

align Value alignment. To align at the left edge of 
the bar, use ‘edge’. To align in the centre 
of the bar, use ‘centre’. 

xfactor Factor to multiply horizontal units by for 
display. 

yfactor Factor to multiply vertical units by for 
display. 

xsuffix Horizontal unit suffix. 

ysuffix Vertical unit suffix. 

dpi Resolution of the histogram. 

class Map(Element) 

__init__(self, size, dpi=300) 

Parameters 

size A tuple containing width, height of the map, 
in millimeters. 

dpi Resolution of the map, in pixels per inch. 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

class PageBreak(Element) 

__init__(self) 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 
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class ParagraphAndImage(Element) 

__init__(self, paragraph, img, side=’left’) 

Parameters 

paragraph A Paragraph element. 

img An Image element. 

side The side the image goes on. Available 
options are ‘left’ or ‘right’. 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

class Spacer(Element) 

__init__(self, width, height) 

Parameters 

width Width of the spacer in millimeters. 

height Height of the spacer in millimeters. 

getFlowables(self) 

Returns a list of ReportLab flowable objects. 

directaid.reports.labels 

class MidpointLabel(Label) 

__init__(self, width, fontsize) 

Parameters 

width Width of the label in millimeters. 

fontsize Size of the font (point size). 

Returns write something here. 

class ProjectLabel(Label) 

__init__(self, width, fontsize) 
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Parameters 

width Width of the label in millimeters. 

fontsize Size of the font (point size). 

Returns write something here. 

class ScaleLabel(Label) 

__init__(self, width, units, fontsize) 

Parameters 

width Width of the label in millimeters. 

units A list of linear unit keys to be displayed in 
the scale bar. For example, 
[‘KILOMETERS’, ‘U.S. SURVEY 
MILES’]. 

fontsize Size of the font (point size). 

Returns write something here. 

class SurveyLabel(Label) 

__init__(self, width, text, srv, fontsize) 

Parameters 

width Width of the label in millimeters. 

text Survey layer type, e.g. ‘Source’ or 
‘Receiver’. 

srv The survey layer the label describes. 

fontsize Size of the font (point size). 

Returns write something here. 

class GeometryLabel(Label) 

__init__(self, width, fontsize) 

Parameters 
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width Width of the label in millimeters. 

fontsize Size of the font (point size). 

Returns write something here. 

directaid.reports.pages 

class CrosslineSummary(Chapter) 

__init__(self, doc, options, width, template=None, 
parentTemplate=None) 

Parameters 

doc Parent document. 

options Report options. 

width Label width in millimeters. 

template Page template for this chapter. 

parentTemplate Page template for parent chapter. 

Returns write something here. 

options(options) 

Parameters 

options Report options. 

Adds options for this element to the options list. 

class LineSummary(Chapter) 

__init__(self, doc, options, width, survey, 
template=None, parentTemplate=None, title='Line 
Summary') 

Parameters 

doc Parent document. 

options Report options. 
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width Label width in millimeters. 

survey Survey layer for line summary. 

template Page template for this chapter. 

parentTemplate Page template for parent chapter. 

title Chapter title. 

options(options) 

Parameters 

options Report options. 

Adds options for this element to the options list. 

class ParameterSummary(Chapter) 

__init__ (self, doc, options, width, 
template=None, parentTemplate=None) 

Parameters 

doc Parent document. 

options Report options. 

width Label width in millimeters. 

template Page template for this chapter. 

parentTemplate Page template for parent chapter. 

Returns write something here. 

options(options) 

Parameters 

options Report options. 

Adds options for this element to the options list. 
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class ProjectPage(Page) 

__init__ (self, options, pagesize, scale=None, 
title=None) 

Parameters 

options Report options. 

pagesize A tuple containing width, height of the page. 

scale Map scale (map units per page unit), or 
None to keep the current scale. 

title Page title. 

options(options) 

Parameters 

options Report options. 

Adds options for this element to the options list. 

class MidpointPage(ProjectPage) 

__init__ (self, options, pagesize, mp, valuePlot, 
detailPlot, binGrid=False, scale=None, 
title=None) 

Parameters 

options Report options. 

pagesize A tuple containing width, height of the 
page. 

mp Active midpoint layer. 

valuePlot See plottypes on page A-8. 

detailPlot See plottypes on page A-8. 

binGrid Draw bin grid. 

scale Map scale (map units per page unit), or 
None to keep the current scale. 
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title Page title. 

directaid.reports.pdf 

class PdfBookmark(ActionFlowable) 

__init__(self, title=None) 

Parameters 

title Bookmark title. 

apply(self, doc) 

Parameters 

doc Parent document. 

Executes the action (see ReportLab documentation for 
ActionFlowable). 

class PdfDocument(Document) 

__init__(self, options, title=None, author=None) 

Parameters 

options Report options. 

title Document title. 

author Document author. 

options(options, filename=’Report.pdf’) 

Parameters 

options Report options. 

filename Default filename. 

Adds options for this element to the options list. 

save(self) 

Writes the document. 
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getValidPath(self, filename) 

Parameters 

filename Base filename. 

Appends a number to filename, if necessary, to ensure that the 
filename is unique. 

createTemplates(self) 

Returns a list of ReportLab PageTemplates. 

class PdfDocTemplate(BaseDocTemplate) 

__init__(self, filename, pagesize, templates, 
title=None, author=None) 

Parameters 

filename Document filename. 

pagesize A tuple containing width, height of the page. 

templates A list of ReportLab PageTemplates. 

title Document title. 

author Document author. 

build(self, flowables, onPage=_doNothing, 
canvasmaker=Canvas) 

Parameters 

flowables List of ReportLab flowables. 

onPage Function called whenever a new 
page is created.. 

canvasmaker Function that returns a Canvas 
object. 

handle_pageEnd(self) 

Called when a page is completed. 

beforeDocument(self) 
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Called before flowables are processed. 

setNextPageTemplate(self, pt) 

Parameters 

pt New page template. 

class SetPageTemplate(ActionFlowable) 

__int__(self, pt) 

Parameters 

pt New page template. 

apply(self, doc) 

Parameters 

doc Parent document. 

Executes the page template change. 

directaid.utils 

getNextIncrement(inc) 

Parameters 

inc The previous value in the sequence. 

Returns the next value in the sequence 1, 2, 5, 10, 20, 50, … 
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